Product notice

This user guide describes features that are common to most models. Some features may not be available on your computer.

Not all features are available in all editions of Windows. This computer may require upgraded and/or separately purchased hardware, drivers and/or software to take full advantage of Windows functionality. Go to http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or otherwise using any software product preinstalled on this computer, you agree to be bound by the terms of the HP End User License Agreement (EULA). If you do not accept these license terms, your sole remedy is to return the entire unused product (hardware and software) within 14 days for a full refund subject to the refund policy of your seller.

For any further information or to request a full refund of the price of the computer, please contact your seller.

This computer may require upgraded and/or separately purchased hardware and/or a DVD drive to install the Windows 7 software and take full advantage of Windows 7 functionality. See http://windows.microsoft.com/en-us/windows7/get-know-windows-7 for details.
Important Notice about Customer Self-Repair Parts

⚠️ CAUTION: Your computer includes Customer Self-Repair parts and parts that should only be accessed by an authorized service provider. See Chapter 5, "Removal and replacement procedures for Customer Self-Repair parts," for details. Accessing parts described in Chapter 6, "Removal and replacement procedures for Authorized Service Provider only parts," can damage the computer or void your warranty.
Important Notice about Customer Self-Repair Parts
Safety warning notice

⚠️ **WARNING!** To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of Information Technology Equipment (IEC 60950).
Table of contents

1 Product description ....................................................................................................................................... 1

2 External component identification .................................................................................................................. 9
   Display .................................................................................................................................................................... 9
   Top ........................................................................................................................................................................ 10
       TouchPad ........................................................................................................................................... 10
       Lights ................................................................................................................................................. 11
       Buttons, speakers, and fingerprint reader (select models only) ...................................................... 12
       Keys ................................................................................................................................................... 13
   Bottom ................................................................................................................................................................. 14
   Front ..................................................................................................................................................................... 16
   Left ....................................................................................................................................................................... 16
   Right ..................................................................................................................................................................... 18
   Labels ................................................................................................................................................................... 19

3 Illustrated parts catalog .............................................................................................................................. 20
   Computer major components .............................................................................................................................. 20
   Display components ............................................................................................................................................ 26
   Cable Kit ............................................................................................................................................................... 27
   Mass storage devices ........................................................................................................................................... 28
   Miscellaneous parts ............................................................................................................................................. 28

4 Removal and replacement procedures preliminary requirements .................................................................... 30
   Tools required ...................................................................................................................................................... 30
   Service considerations ......................................................................................................................................... 30
       Plastic parts ....................................................................................................................................... 30
       Cables and connectors ...................................................................................................................... 31
       Drive handling ................................................................................................................................... 31
       Grounding guidelines ........................................................................................................................ 32
           Electrostatic discharge damage ........................................................................................................ 32
               Packaging and transporting guidelines .......................................................................................... 33
               Workstation guidelines ................................................................................................................ 33
               Equipment guidelines .................................................................................................................. 34

5 Removal and replacement procedures for Customer Self-Repair parts ............................................................. 35
   Component replacement procedures .................................................................................................................. 35
6 Removal and replacement procedures for Authorized Service Provider parts .............................................. 53
   Component replacement procedures .......................................................................................................... 53
      Top cover ....................................................................................................................................................... 53
      RTC battery, HP 445 models ....................................................................................................................... 56
      Speaker assembly .......................................................................................................................................... 57
      Fingerprint reader assembly ....................................................................................................................... 59
      Power button board ..................................................................................................................................... 60
      Function board .............................................................................................................................................. 62
      Card reader board ......................................................................................................................................... 63
      USB/audio board .......................................................................................................................................... 65
      Touchpad button board ............................................................................................................................... 67
      Fan ............................................................................................................................................................... 69
      Battery connector cable ............................................................................................................................... 71
      System board ............................................................................................................................................... 72
      Optical drive extension board ..................................................................................................................... 76
      RTC battery, HP 440 models ....................................................................................................................... 77
      Heat sink assembly ..................................................................................................................................... 79
      Display assembly .......................................................................................................................................... 82
      Power connector and cable ........................................................................................................................... 88

7 Computer Setup (BIOS) and MultiBoot in Windows 7 .................................................................................... 89
   Using Computer Setup ................................................................................................................................... 89
      Starting Computer Setup ............................................................................................................................. 89
      Navigating and selecting in Computer Setup ............................................................................................. 89
      Restoring factory settings in Computer Setup ........................................................................................... 90
      Updating the BIOS ...................................................................................................................................... 90
         Determining the BIOS version .................................................................................................................. 90
         Downloading a BIOS update ................................................................................................................... 91
   Using MultiBoot .............................................................................................................................................. 91
      About the boot device order .......................................................................................................................... 91
      Choosing MultiBoot preferences .................................................................................................................. 92
         Setting a new boot order in Computer Setup .......................................................................................... 92
8  Computer Setup (BIOS) and MultiBoot in Windows 8 ................................................................. 94
Using Computer Setup .............................................................................................................. 94
   Starting Computer Setup ...................................................................................................... 94
   Navigating and selecting in Computer Setup ........................................................................ 94
   Restoring factory settings in Computer Setup ................................................................…… 95
   Updating the BIOS ............................................................................................................... 95
      Determining the BIOS version ...................................................................................... 95
      Downloading a BIOS update .......................................................................................... 96
Using MultiBoot .......................................................................................................................... 97
   About the boot device order ............................................................................................... 97
   Choosing MultiBoot preferences ....................................................................................... 97
      Setting a new boot order in Computer Setup .................................................................. 97
      Dynamically choosing a boot device using the f9 prompt ............................................ 98
      Setting a MultiBoot Express prompt .......................................................................... 98
      Entering MultiBoot Express preferences ..................................................................... 98

9  Computer Setup (BIOS), TPM, and HP Sure Start in Windows 10 .............................................. 99
Using Computer Setup .............................................................................................................. 99
   Starting Computer Setup .................................................................................................... 99
   Navigating and selecting in Computer Setup ..................................................................... 99
   Restoring factory settings in Computer Setup .................................................................... 100
   Updating the BIOS ............................................................................................................ 101
      Determining the BIOS version ................................................................................. 101
      Downloading a BIOS update ...................................................................................... 101
      Changing the boot order using the f9 prompt ............................................................. 102
   TPM BIOS settings (select products only) ........................................................................... 102
   Using HP Sure Start (select products only) ....................................................................... 103

10 Computer Setup (BIOS) in Ubuntu Linux ................................................................................. 104
Starting Computer Setup ....................................................................................................... 104
Using Computer Setup .......................................................................................................... 104
   Navigating and selecting in Computer Setup .................................................................... 104
   Restoring factory settings in Computer Setup .................................................................. 105
Updating the BIOS .................................................................................................................. 105
   Determining the BIOS version ...................................................................................... 105
   Downloading a BIOS update .......................................................................................... 106
11 HP PC Hardware Diagnostics (UEFI) ............................................................................................................ 107
   Downloading HP PC Hardware Diagnostics (UEFI) to a USB device ....................................................... 107

12 Backup and recovery in Windows 7 ............................................................................................................ 109
   Creating recovery media and backups ........................................................................................................ 109
      Guidelines ........................................................................................................................................ 109
      Creating recovery media with HP Recovery Disc Creator ............................................................... 109
         Creating recovery media .................................................................................................................. 110
      Backing up your information ............................................................................................................... 110
   Performing a system recovery ............................................................................................................... 111
      Using the Windows recovery tools .................................................................................................. 111
      Using f11 recovery tools (select models only) ............................................................................... 112
      Using Windows 7 operating system media ..................................................................................... 112

13 Backup and recovery in Windows 8 ............................................................................................................ 114
   Backing up your information .................................................................................................................... 114
   Performing a system recovery ............................................................................................................... 114
      Using the Windows recovery tools ................................................................................................ 114
      Using f11 recovery tools ................................................................................................................ 115
      Using Windows operating system media (purchased separately) .................................................. 116
      Using Windows Refresh or Windows Reset ................................................................................... 116
      Using HP Software Setup ........................................................................................................... 116

14 Backup and recovery in Windows 10 .......................................................................................................... 117
   Creating recovery media and backups .................................................................................................... 117
      Creating HP Recovery media (select products only) ....................................................................... 117
   Using Windows tools .............................................................................................................................. 118
   Restore and recovery ........................................................................................................................................ 119
      Recovering using HP Recovery Manager ........................................................................................ 119
         What you need to know before you get started ........................................................................ 119
      Using the HP Recovery partition (select products only) ............................................................. 120
      Using HP Recovery media to recover ........................................................................................ 120
      Changing the computer boot order ............................................................................................. 121
      Removing the HP Recovery partition (select products only) ....................................................... 122

15 Backup and Recovery in Ubuntu Linux ....................................................................................................... 123
   Creating backups ......................................................................................................................................... 123
   Backing up your information .................................................................................................................. 123
   Performing a system recovery ................................................................................................................ 124
   USB Recovery option (select models only) .......................................................................................... 124
# Product description

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>HP 440 UMA</th>
<th>HP 440 discrete</th>
<th>HP 445 UMA</th>
<th>HP 445 discrete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>HP ProBook 440 G2 Notebook PC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP ProBook 445 G2 Notebook PC</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Processors</td>
<td>Intel® Core™ i7 processor, Dual Core, 4th generation (4-MB L3 cache)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4510U, 2.0-GHz/3.1-GHz Core Turbo/Intel HD Graphics 4400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel® Core i5 processors, Dual Core, 4th generation (3-MB L3 cache)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4310U, 2.0-GHz/3.0-GHz Core Turbo processor/Intel HD Graphics 4400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4210U, 1.7-GHz/2.7-GHz Core Turbo processor/Intel HD Graphics 4400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Core i3 processors, Dual Core, 4th generation (3-MB L3 cache)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4030U, 1.9-GHz processor/Intel HD Graphics 4400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4005U, 1.7-GHz processor/Intel HD Graphics 4400</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Celeron processor (2-MB L3 cache)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2957U, 1.4-GHz processor/Intel HD Graphics</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Core i7 processor, Dual Core, 5th generation (1600MHz, 4-MB L3 cache, 15W, Intel HD 5500 Graphics)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5500U, 2.4-GHz/3.0-GHz Core Turbo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Core i5 processor, Dual Core, 5th generation (1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5300U, 2.3-GHz/2.9-GHz Core Turbo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5200U, 2.2-GHz/2.7-GHz Core Turbo</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Core i3 processor, Dual Core, 5th generation (1600MHz, 3-MB L3 cache, 15W, Intel HD 5500 Graphics)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5020U, 2.2-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5015U, 2.1-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5010U, 2.1-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5005U, 2.0-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel Celeron, Broadwell, Dual Core (1600MHz, 2-MB L3 cache, 15W, Intel HD Graphics)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3215U, 1.7-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3205U, 1.5-GHz</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AMD processors</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>HP 440 UMA</td>
<td>HP 440 discrete</td>
<td>HP 445 UMA</td>
<td>HP 445 discrete</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------------</td>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chipset</td>
<td>Integrated with processor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AMD A76M FCH</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Graphics</td>
<td>Integrated UMA:</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>See processor category</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Switchable discrete (Intel processors):</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AMD Radeon RS M255 with 2 GB or 1 GB dedicated video memory</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Switchable discrete (AMD processors):</strong></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A10 series APU - Graphic Branding AMD Radeon R7 M260DX with 2 GB or 1 GB dedicated video memory</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A8 series APU - Graphic Branding AMD Radeon R6 M255DX with 2 GB or 1 GB dedicated video memory</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6 series APU - Graphic Branding AMD Radeon RS M255 with 2 GB or 1 GB dedicated video memory</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports HD decode, DX11, HDMI</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Supports PX7</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports PX5</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panel</td>
<td><strong>HD eDP – flat</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD, anti-glare, 1366x768, 200 nits, 3.6 mm, 1 or 2 WLAN antennas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD, anti-glare, 1366x768, 200 nits, 3.6 mm, 1 or 2 WLAN antennas, camera</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD, anti-glare, 1366x768, 200 nits, 3.6 mm, 1 or 2 WLAN antennas, WWAN, camera</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD, 1366x768, 200 nits, 3.6 mm, touch panel, 1 or 2 WLAN antennas, camera</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>HD+ eDP – flat</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD+, anti-glare, 1600x900, 250 nits, 3.6 mm, 1 or 2 WLAN antennas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>35.6-cm (14.0-inch) HD+, anti-glare, 1600x900, 250 nits, 3.6 mm, 1 or 2 WLAN antennas, camera</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All display assemblies include 1 or 2 wireless local area network (WLAN) antennas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Display assemblies include 2 worldwide 5-band (WWAN) antennas</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>HP 440 UMA</td>
<td>HP 440 discrete</td>
<td>HP 445 UMA</td>
<td>HP 445 discrete</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
<td>-----------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Memory</td>
<td>Two customer-accessible memory module slots supporting up to 16 GB of RAM</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Supports dual-channel memory</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>PC3L-12800, 1600-MHz, DDR3L SODIMMs</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Supports the following configurations:</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>● 16384 MB (8192 × 2; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 12288 MB (8192 + 4096; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 8192 MB (8192 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 8192 MB (4096 × 2; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 6144 MB (4096 + 2048; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 4096 MB (4096 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 2048 MB (2048 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the following configurations (Brazil):</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 16384 MB (8192 × 2; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 8192 MB (8192 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 8192 MB (4096 × 2; dual channel)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 4096 MB (4096 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 2048 MB (2048 × 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Primary storage</td>
<td>Supports 7-mm/9.5-mm, 2.5-in SATA hard drives with HP 3D DriveGuard</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Customer-accessible</td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Supports the following drives:</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 2-TB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 1.5-TB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 1-TB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 750-GB, 7200-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 750-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 500-GB, 7200-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 500-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 500-GB, 5400-rpm, hybrid (8-GB SSD) MLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 320-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 512-GB Solid-state drive (SSD)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 512-GB Solid-state drive (SSD), TLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 128-GB Solid-state drive (SSD), MLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 128-GB Solid-state drive (SSD), TLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports the following drives:</td>
<td>√</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>● 1.5-TB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>HP 440 UMA</td>
<td>HP 440 discrete</td>
<td>HP 445 UMA</td>
<td>HP 445 discrete</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------------</td>
<td>-----------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td>• 1-TB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 750-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 500-GB, 7200-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 500-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 320-GB, 5400-rpm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 512-GB Solid-state drive (SSD), TLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 128-GB Solid-state drive (SSD), TLC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 128-GB Solid-state drive (SSD)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mini-card SSD</td>
<td><strong>M.2 2242 SSD</strong></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>120 GB</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set as primary storage if selected. Not available with Celeron or Pentium processors. Not available with WWAN.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed optical drives</td>
<td>Supports the following 9.5-mm SATA optical drives:</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• DVD-ROM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• DVD+/-RW SuperMulti DL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Blu-ray ROM DVD+/-RW SuperMulti DL</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports no optical drive option</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Audio/Visual</td>
<td>Integrated camera (720p HD)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Stereo speakers (2)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Integrated dual-array microphone (webcam models only)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Integrated mono microphone (non-webcam models only)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Headphone/microphone combo jack</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Realtek ALC3227-CG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Skype-ready</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>HD audio with DTS Sound+</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Supports “no camera” option</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Realtek RTL8161GSH-CG 10/100/1000</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>S3/S4/S5 wake on LAN (AC mode and battery mode)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>NIC power down technology</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Ethernet cable not included</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Wireless</td>
<td><strong>Integrated WLAN options by way of wireless module:</strong></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>WLAN antennas built into display assembly</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Supports “no WLAN/Bluetooth” option</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Integrated WLAN options via Minicard:</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>• QCA 802.11 b/g/n 1x1 (Marilyn) Backup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>HP 440 UMA</td>
<td>HP 440 discrete</td>
<td>HP 445 UMA</td>
<td>HP 445 discrete</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------------</td>
<td>------------</td>
<td>----------------</td>
</tr>
<tr>
<td>●</td>
<td>Broadcom 802.11 a/b/g/n 2x2 +BT Combo (Bumblebee) w/o WiDi</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Broadcom 802.11 b/g/n 1x1 +BT Combo (Harrier) Backup</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Realtek 802.11 b/g/n 1x1 (Focus)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Realtek 802.11 b/g/n 1x1 +BT Combo (Skyray)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports the following WLAN formats:</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Intel 802.11 a/b/g/n/AC 2x2 +BT Combo (Wilkins Peak 2) - no vPro</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>Intel 802.11 a/b/g/n/AC 1x1 +BT Combo (Wilkins Peak 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wireless Personal Area Network (PAN) only supported by Bluetooth 4.0 combo card</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Integrated WWAN options by way of wireless module:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Two WWAN antennas built into display assembly (worldwide 5 band, configured with panels)</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subscriber identity module (SIM) security (customer-accessible)</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports &quot;no WWAN&quot; option</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supports the following WWAN modules:</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>●</td>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External media card</td>
<td>Digital Media Reader Slot</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Supports SD, SDHC, SDXC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ports</td>
<td>Headphone/Microphone Combo Jack</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RJ-45 (Ethernet, includes link and activity lights)</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>USB 3.0 (2)</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>USB 2.0 (2)</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>VGA (Dsub 15-pin) supporting 2048 × 1536 external resolution at 50-GHz (hot plug/unplug with auto-detect)</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VGA (Dsub 15-pin) supporting 1920 × 1200 external resolution at 60-GHz (hot plug/unplug with auto-detect)</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI 1.4</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Multi-pin AC port</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Keyboard/pointing devices</td>
<td>Full-sized, chiclet, spill-resistant keyboard</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Backlit, full-sized, chiclet, spill-resistant keyboard</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Touchpad includes: on/off button on board; 2-way scroll with legend, taps enabled by default, 2-finger scrolling and zoom enabled by default</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Category</td>
<td>Description</td>
<td>HP 440 UMA</td>
<td>HP 440 discrete</td>
<td>HP 445 UMA</td>
<td>HP 445 discrete</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>-----------------</td>
<td>------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Power requirements</td>
<td>90-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>45-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>40-W, 2-prong AC adapter</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Power cord: 3-wire plug - 1.8 m or 1.0 m</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Power cord: 2-wire plug - 1.0 m</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-cell, 44-Wh, 3.0 Ah, Li-ion battery</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>4-cell, 40-Wh, 3.0 Ah, Li-ion battery (long life)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Security</td>
<td>Integrated fingerprint reader</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>No fingerprint reader option</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Security lock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TPM SLB9660 (FW ver. 1.2) (Infineon; soldered down)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TPM support</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Operating system</td>
<td>Preinstalled:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Premium 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Basic 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64-bit Digital Product Key (DPK) with Windows 7 Professional 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64-bit Digital Product Key (DPK) with Windows 7 Professional 64 – MSNA</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 China (CH) 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Emerging Markets (EM) 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Multi-language (ML) 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64-bit – MSNA</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 Single Language</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 Chinese Market</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 Chinese Market – CPPP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 StF MSNA for Higher Education</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 High-end</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10 Home 64 High-end Single Language</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chapter 1  Product description
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>HP 440</th>
<th>HP 440</th>
<th>HP 445</th>
<th>HP 445</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 10 Home 64 High-end Chinese Market</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional StF MSNA</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional StF MSNA EM</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional 64 Downgrade Windows 7 32 StF MSNA</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional 64 Downgrade Windows 7 64 StF MSNA</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional 64 Downgrade Windows 7 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Professional 64 Downgrade Windows 7 64 StF MSNA</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>FreeDOS 2.0</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Ubuntu Linux</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Restore Media (DRDVD/SRDVD):</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DRDVD Windows 10</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>DRDVD Windows 8.1</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>DRDVD Windows 7</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>SRDVD Ubuntu Linux</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Restore Media (OSDVD):</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Basic 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Premium 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional 32</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Professional 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 64-bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Country Specific 64-Bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Emerging Market 64-Bit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Web-only support:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional 32</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise 32</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 8.1 Enterprise 64</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>Windows 10 Enterprise</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Certified:**
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>HP 440 UMA</th>
<th>HP 440 discrete</th>
<th>HP 445 UMA</th>
<th>HP 445 discrete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft WHQL</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td><strong>Serviceability</strong></td>
<td><strong>End-user replaceable parts:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AC adapter</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Battery (system)</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Hard drive</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Memory module</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Optical drive</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>WLAN module</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>WWAN module</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td></td>
<td>√</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>
2 External component identification

Display

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) WLAN antennas (2)* (select models only)</td>
<td>Send and receive wireless signals to communicate with wireless local area networks (WLAN).</td>
</tr>
<tr>
<td>(2) WWAN antennas (2)* (select models only)</td>
<td>Send and receive wireless signals to communicate with wireless wide area networks (WWAN).</td>
</tr>
<tr>
<td>(3) Internal microphones (2) (select models only)</td>
<td>Record sound.</td>
</tr>
<tr>
<td>(4) Webcam light (select models only)</td>
<td>On: The webcam is in use.</td>
</tr>
<tr>
<td>(5) Webcam (select models only)</td>
<td>Records video and captures photographs. Some models allow you to video conference and chat online using streaming video.</td>
</tr>
<tr>
<td></td>
<td>To use the webcam:</td>
</tr>
<tr>
<td></td>
<td><strong>Windows 7</strong>: Select Start &gt; All Programs &gt; Communication and Chat &gt; CyberLink YouCam.</td>
</tr>
<tr>
<td></td>
<td><strong>Windows 8.1</strong>: Access HP Support Assistant. To access HP Support Assistant, from the Start screen, select the HP Support Assistant app.</td>
</tr>
<tr>
<td></td>
<td><strong>Windows 10</strong>: Type camera in the taskbar search box, and then select Camera.</td>
</tr>
<tr>
<td>(6) Internal display switch</td>
<td>Turns off the display or initiates Sleep if the display is closed while the power is on.</td>
</tr>
</tbody>
</table>
Component Description

*NOTE:* The display switch is not visible from the outside of the computer.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around the antennas free from obstructions. For wireless regulatory notices, see the section of the *Regulatory, Safety, and Environmental Notices* that applies to your country or region. To access this guide:

**Windows 7:** Select Start > Help and Support > User Guides.

**Windows 8.1:** From the Start screen, type `support`, and then select the *HP Support Assistant* app.

**Windows 10:** Select Start, select *All apps*, select *HP Help and Support*, and then select *HP Documentation*.

### Top

#### TouchPad

![TouchPad diagram]

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) TouchPad on/off button</td>
<td>Turns the TouchPad on and off.</td>
</tr>
<tr>
<td>(2) TouchPad zone</td>
<td>Moves the pointer and selects or activates items on the screen.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The TouchPad also supports edge-swipe gestures.</td>
</tr>
<tr>
<td>(3) Left TouchPad button</td>
<td>Functions like the left button on an external mouse.</td>
</tr>
<tr>
<td>(4) Right TouchPad button</td>
<td>Functions like the right button on an external mouse.</td>
</tr>
</tbody>
</table>
## Lights

**NOTE:** Refer to the illustration that most closely matches your computer.

![Lights Diagram](image)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| **(1)** Power light | - On: The computer is on.  
- Blinking: The computer is in the Sleep state, a power-saving state. The computer shuts off power to the display and other unneeded components.  
- Off: The computer is off or in Hibernation. Hibernation is a power-saving state that uses the least amount of power. |
| **(2)** Caps lock light | On: Caps lock is on, which switches the keys to all capital letters. |
| **(3)** Microphone mute light | - Amber: microphone sound is off.  
- Off: microphone sound is on. |
| **(4)** Num lock light | On: Num lock is on. |
| **(5)** Wireless light | White: An integrated wireless device, such as a wireless local area network (WLAN) device and/or a Bluetooth® device, is on.  
**NOTE:** On some models, the wireless light is amber when all wireless devices are off. |
| **(6)** Speaker mute light | - Amber: Computer sound is off.  
- White: Computer sound is on. |
| **(7)** TouchPad light | - Amber: The TouchPad is off.  
- Off: The TouchPad is on. |
Buttons, speakers, and fingerprint reader (select models only)

**NOTE:** Refer to the illustration that most closely matches your computer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Power button | - When the computer is off, press the button to turn on the computer.  
- When the computer is on, press the button briefly to initiate Sleep.  
- When the computer is in the Sleep state, press the button briefly to exit Sleep.  
- When the computer is in Hibernation, press the button briefly to exit Hibernation.  

**CAUTION:** Pressing and holding down the power button will result in the loss of unsaved information.

If the computer has stopped responding and Windows® shutdown procedures are ineffective, press and hold the power button for at least 5 seconds to turn off the computer.

To learn more about your power settings, see your power options:

**Windows 7:** Select **Start > Control Panel > System and Security > Power Options.**

**Windows 8.1:** From the Start screen, type **power**, select **Power and sleep settings**, and then select **Power and sleep** from the list of applications.

**Windows 10:** Type **power** in the taskbar search box, and then select **Power and sleep settings.**
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click the <strong>Start</strong> button, and then select <strong>Power Options</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>(2)</strong> Speakers (2)</td>
<td>Produce sound.</td>
</tr>
<tr>
<td><strong>(3)</strong> Wireless button</td>
<td>Turns the wireless feature on or off but does not establish a wireless connection.</td>
</tr>
<tr>
<td><strong>(4)</strong> Speaker mute button</td>
<td>Mutes and restores speaker sound.</td>
</tr>
<tr>
<td><strong>(5)</strong> Fingerprint reader (select models only)</td>
<td>Allows a fingerprint logon to Windows, instead of a password logon.</td>
</tr>
</tbody>
</table>

### Keys

**NOTE:** Refer to the illustration that most closely matches your computer.

![Keyboard Illustration]

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(1)</strong> esc key</td>
<td>Displays system information when pressed in combination with the fn key.</td>
</tr>
<tr>
<td><strong>(2)</strong> fn key</td>
<td>Executes frequently used system functions when pressed in combination with a function key, the num lk key, or the esc key.</td>
</tr>
</tbody>
</table>
| **(3)** Windows key | **Windows 7:** Displays the Windows Start menu.  
**Windows 8.1:** Returns you to the Start screen from an open app or the Windows desktop.  
**NOTE:** Pressing the Windows key again will return you to the previous screen.  
**Windows 10:** Opens the Windows Start menu.  
**NOTE:** Pressing the Windows key again will close the Start menu. |
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4)</td>
<td>Function keys</td>
</tr>
<tr>
<td>(5)</td>
<td>Embedded numeric keypad</td>
</tr>
<tr>
<td>(6)</td>
<td>Windows applications key</td>
</tr>
<tr>
<td>(7)</td>
<td>num lk key</td>
</tr>
</tbody>
</table>

**Bottom**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Vents (2)</td>
</tr>
</tbody>
</table>
### Component Description

**NOTE:** The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2) Service door</td>
<td>Provides access to the hard drive bay and the memory module slots.</td>
</tr>
<tr>
<td>(3) Battery release latch</td>
<td>Releases the battery.</td>
</tr>
<tr>
<td>Battery lock latch</td>
<td>Locks the battery in the battery bay.</td>
</tr>
<tr>
<td>(4) Service door</td>
<td>Provides access to the wireless LAN (WLAN) module slot, the WWAN module slot, and SIM slot. <strong>CAUTION:</strong> To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and then receive a warning message, remove the module to restore computer functionality, and then contact support through HP Support Assistant. To access Help and Support in Windows 7: Select Start &gt; Help and Support. To access HP Support Assistant: in Windows 8.1: From the Start screen, select the HP Support Assistant app. Windows 10: Type support in the taskbar search box, and then select the HP Support Assistant app. - or - Click the question mark icon in the taskbar.</td>
</tr>
<tr>
<td>(5) Battery bay</td>
<td>Holds the battery.</td>
</tr>
<tr>
<td>(6) SIM slot (select models only)</td>
<td>Supports a wireless subscriber identity module (SIM). The SIM slot is located under the service door.</td>
</tr>
</tbody>
</table>
### Front

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Hard drive light</td>
<td>● Blinking white: The hard drive is being accessed.</td>
</tr>
<tr>
<td></td>
<td>● Amber: HP 3D DriveGuard has temporarily parked the hard drive.</td>
</tr>
<tr>
<td>(2) Memory card reader</td>
<td>Reads optional memory cards that store, manage, share, or access information.</td>
</tr>
</tbody>
</table>

### Left

**NOTE:** Refer to the illustration that most closely matches your computer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Security cable slot</td>
<td>Attaches an optional security cable to the computer.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The security cable is designed to act as a deterrent, but it may not prevent the computer from being mishandled or stolen.</td>
</tr>
<tr>
<td>(2) Power connector</td>
<td>Connects an AC adapter.</td>
</tr>
<tr>
<td>(3) AC adapter/Battery light</td>
<td>● White: The computer is connected to external power and the battery is charged from 90 to 99 percent.</td>
</tr>
<tr>
<td></td>
<td>● Amber: The computer is connected to external power and the battery is charged from 0 to 89 percent.</td>
</tr>
<tr>
<td></td>
<td>● Off: The battery is fully charged.</td>
</tr>
<tr>
<td>(4) Vent</td>
<td>Enables airflow to cool internal components.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The computer fan starts up automatically to cool internal components and prevent overheating. It is normal for the internal fan to cycle on and off during routine operation.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>(5) External monitor port</td>
<td>Connects an external VGA monitor or projector.</td>
</tr>
</tbody>
</table>
| (6) RJ-45 (network) jack/lights | Connects a network cable.  
  - Green (right): The network is connected.  
  - Amber (left): Activity is occurring on the network. |
| (7) HDMI port | Connects an optional video or audio device, such as a high-definition television, any compatible digital or audio component, or a high-speed HDMI device. |
| (8) USB 3.0 ports (2) | Each USB 3.0 port connects an optional USB device, such as a keyboard, mouse, external drive, printer, scanner or USB hub. |
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| (1) Audio-out (headphone)/Audio-in (microphone) jack | Connects optional powered stereo speakers, headphones, earbuds, or a headset. Also connects an optional headset microphone. This jack does not support optional microphone-only devices.  
**WARNING!** To reduce the risk of personal injury, adjust the volume before putting on headphones, earbuds, or a headset. For additional safety information, see the *Regulatory, Safety, and Environmental Notices*. To access this document:  
**Windows 7:**  
Select **Start > Help and Support > User Guides**.  
**Windows 8.1:**  
From the Start screen, type **support**, and then select the **HP Support Assistant** app.  
 Or  
From the Windows desktop, click the question mark icon in the notification area, at the far right of the taskbar.  
**Windows 10:**  
Select **Start**, select **All apps**, select **HP Help and Support**, and then select **HP Documentation**.  
**NOTE:** When a device is connected to the jack, the computer speakers are disabled.  
**NOTE:** Be sure that the device cable has a 4-conductor connector that supports both audio-out (headphone) and audio-in (microphone). |
| (2) USB 2.0 ports (2) | Connects an optional USB device, such as a keyboard, mouse, external drive, printer, scanner or USB hub. |
| (3) Optical drive (select models only) | Depending on your computer model, reads an optical disc or reads and writes to an optical disc. |
| (4) Optical drive eject button (select models only) | Releases the optical drive disc tray. |
Labels

The labels affixed to the computer provide information you may need when you troubleshoot system problems or travel internationally with the computer.

**IMPORTANT:** Check the following locations for the labels described in this section: the bottom of the computer, inside the battery bay, under the service door, or on the back of the display.

- Service label—Provides important information to identify your computer. When contacting support, you will probably be asked for the serial number, and possibly for the product number or the model number. Locate these numbers before you contact support.

Your service label will resemble one of the examples shown below. Refer to the illustration that most closely matches the service label on your computer.

![Service Label Examples]

<table>
<thead>
<tr>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Serial number</td>
</tr>
<tr>
<td>(2) Product number</td>
</tr>
<tr>
<td>(3) Warranty period</td>
</tr>
<tr>
<td>(4) Model number (select products only)</td>
</tr>
</tbody>
</table>

- Regulatory label(s)—Provide(s) regulatory information about the computer.
- Wireless certification label(s)—Provide(s) information about optional wireless devices and the approval markings for the countries or regions in which the devices have been approved for use.
3 Illustrated parts catalog

Computer major components

NOTE: HP continually improves and changes product parts. For complete and current information on supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then follow the on-screen instructions.

NOTE: Details about your computer, including model, serial number, product key, and length of warranty, are on the service tag at the bottom of your computer. See Labels on page 19 for details.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td><strong>Display panel assembly</strong>, 35.6-cm (14.0-inch), HD, anti-glare</td>
<td>782118-001</td>
</tr>
<tr>
<td></td>
<td>Touch screen</td>
<td>782118-001</td>
</tr>
<tr>
<td></td>
<td>Touch screen, includes two antennas</td>
<td>782531-001</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>(2)</td>
<td><strong>Keyboard</strong> (includes cable)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> For a detailed list of keyboard country codes, see Keyboard on page 49.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No backlight</td>
<td>767470-xxx</td>
</tr>
<tr>
<td></td>
<td>Backlit</td>
<td>767476-xxx</td>
</tr>
<tr>
<td>(3)</td>
<td><strong>Top cover</strong> (includes touchpad assembly)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Models with a fingerprint reader</td>
<td>767454-001</td>
</tr>
<tr>
<td></td>
<td>Models without a fingerprint reader (HP 440 models only)</td>
<td>773564-001</td>
</tr>
<tr>
<td>(4)</td>
<td><strong>Touchpad button board</strong></td>
<td>767455-001</td>
</tr>
<tr>
<td>(5)</td>
<td><strong>Power button board assembly</strong></td>
<td>767442-001</td>
</tr>
<tr>
<td>(6)</td>
<td><strong>Card reader board</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For use in HP 440 models</td>
<td>768052-001</td>
</tr>
<tr>
<td></td>
<td>For use in HP 445 models</td>
<td>767445-001</td>
</tr>
<tr>
<td>(7)</td>
<td><strong>Function board</strong></td>
<td>767443-001</td>
</tr>
<tr>
<td>(8)</td>
<td><strong>Fingerprint reader assembly</strong> (includes cable, bracket, and bezel)</td>
<td>767436-001</td>
</tr>
<tr>
<td>(9)</td>
<td><strong>System board</strong> (includes replacement thermal material)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All system boards use the following part numbers:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>xxxxxx-001: Windows 7 or non-Windows operating systems</td>
<td></td>
</tr>
<tr>
<td></td>
<td>xxxxxx-501: Windows 8.1 Standard operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>xxxxxx-601: Windows 8.1 or Windows 10 operating system</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Intel i7-5500U processor; 2-GB discrete graphics memory</td>
<td>798508-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5300U processor; 2-GB discrete graphics memory</td>
<td>798507-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5200U processor; 2-GB discrete graphics memory</td>
<td>798506-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5020U processor; 2-GB discrete graphics memory</td>
<td>822646-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5010U processor; 2-GB discrete graphics memory</td>
<td>798505-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5005U processor; 2-GB discrete graphics memory</td>
<td>798504-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5200U processor; 1-GB discrete graphics memory</td>
<td>798503-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5020U processor; 1-GB discrete graphics memory</td>
<td>822645-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5010U processor; 1-GB discrete graphics memory</td>
<td>798502-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5005U processor; 1-GB discrete graphics memory</td>
<td>798501-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i7-5500U processor; UMA graphics memory</td>
<td>798497-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5300U processor; UMA graphics memory</td>
<td>798496-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5200U processor; UMA graphics memory</td>
<td>798495-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i5-5200U processor; UMA graphics memory; WWAN models</td>
<td>798500-xxx</td>
</tr>
<tr>
<td></td>
<td>Intel i3-5020U processor; UMA graphics memory</td>
<td>822643-xxx</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Intel i3-5020U processor; UMA graphics memory; WWAN models</td>
<td>822644-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-5010U processor; UMA graphics memory</td>
<td>798494-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-5010U processor; UMA graphics memory; WWAN models</td>
<td>798499-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-5005U processor; UMA graphics memory</td>
<td>798493-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-5005U processor; UMA graphics memory; WWAN models</td>
<td>798498-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel Celeron 3215U processor; UMA graphics memory</td>
<td>825082-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel Celeron 3205U processor; UMA graphics memory</td>
<td>798492-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i7-4510U processor; 2-GB discrete graphics memory</td>
<td>768078-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4310U processor; 2-GB discrete graphics memory</td>
<td>768073-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4210U processor; 2-GB discrete graphics memory</td>
<td>768072-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4030U processor; 2-GB discrete graphics memory</td>
<td>768071-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4005U processor; 2-GB discrete graphics memory</td>
<td>783995-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4210U processor; 1-GB discrete graphics memory</td>
<td>768069-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4030U processor; 1-GB discrete graphics memory</td>
<td>768068-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4210U processor; UMA graphics memory; WWAN models</td>
<td>768064-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i7-4510U processor; UMA graphics memory</td>
<td>768060-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4310U processor; UMA graphics memory</td>
<td>768059-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i5-4210U processor; UMA graphics memory; Non-WWAN models</td>
<td>768058-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4030U processor; UMA graphics memory; WWAN models</td>
<td>768063-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4030U processor; UMA graphics memory; Non-WWAN models</td>
<td>768057-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel i3-4005U processor; UMA graphics memory</td>
<td>783994-xxx</td>
<td></td>
</tr>
<tr>
<td>Intel Celeron 2957U processor; UMA graphics memory</td>
<td>768056-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A10-7300 processor; 2 GB discrete graphics memory</td>
<td>767468-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A8-7100 processor; 2 GB discrete graphics memory</td>
<td>767467-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A6-7050B processor; 2 GB discrete graphics memory</td>
<td>767466-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A10-7300 processor; 1 GB discrete graphics memory</td>
<td>767464-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A8-7100 processor; 1 GB discrete graphics memory</td>
<td>767463-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A6-7050B processor; 1 GB discrete graphics memory</td>
<td>767462-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A10-7300 processor; UMA graphics memory</td>
<td>767460-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A8-7100 processor; UMA graphics memory</td>
<td>767459-xxx</td>
<td></td>
</tr>
<tr>
<td>AMD A6-7050B processor; UMA graphics memory</td>
<td>767458-xxx</td>
<td></td>
</tr>
<tr>
<td><strong>(10) USB/audio board</strong></td>
<td>767444-001</td>
<td></td>
</tr>
<tr>
<td><strong>(11) Memory modules</strong> (PC3L-12800, 1600-MHz, DDR3L)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-GB</td>
<td>693374-001</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>4-GB</td>
<td></td>
<td>691740-001</td>
</tr>
<tr>
<td>2-GB</td>
<td></td>
<td>691739-001</td>
</tr>
<tr>
<td>(12)</td>
<td>Optical drive extension board</td>
<td>not spared</td>
</tr>
<tr>
<td>(13)</td>
<td>WWAN module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
<td>740011-001</td>
</tr>
<tr>
<td></td>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
<td>748599-001</td>
</tr>
<tr>
<td>(14)</td>
<td>RTC battery</td>
<td>759981-001</td>
</tr>
<tr>
<td>(15)</td>
<td>WLAN module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter</td>
<td>675794-001</td>
</tr>
<tr>
<td></td>
<td>Realtek RT8188EE 802.11bgn Wi-Fi Adapter</td>
<td>709848-001</td>
</tr>
<tr>
<td></td>
<td>Intel Dual Band Wireless-AC 3160 802.11 ac 1x1 WiFi + BT 4.0 combo adapter</td>
<td>710662-001</td>
</tr>
<tr>
<td></td>
<td>Broadcom BCM943228HMB 802.11abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter</td>
<td>730668-001</td>
</tr>
<tr>
<td></td>
<td>Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 HMC combo adapter</td>
<td>753076-001</td>
</tr>
<tr>
<td></td>
<td>Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter</td>
<td>753077-001</td>
</tr>
<tr>
<td></td>
<td>Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 combo adapter</td>
<td>756753-001</td>
</tr>
<tr>
<td></td>
<td><strong>Heat sink assembly</strong> (includes replacement thermal material)</td>
<td></td>
</tr>
<tr>
<td>(16)</td>
<td>● For use in models with discrete graphics and all processors except for the Intel i7-4558U</td>
<td>768050-001</td>
</tr>
<tr>
<td></td>
<td>● For use in models with discrete graphics and an Intel i5-4210U processor</td>
<td>768049-001</td>
</tr>
<tr>
<td>(17)</td>
<td>● For use in models with UMA graphics</td>
<td>768048-001</td>
</tr>
<tr>
<td></td>
<td>For use in HP 445 models (AMD)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>● For use in models with UMA graphics</td>
<td>767435-001</td>
</tr>
<tr>
<td></td>
<td>● For use in models with discrete graphics</td>
<td>767434-001</td>
</tr>
<tr>
<td>(18)</td>
<td><strong>Power connector and cable</strong></td>
<td>767432-001</td>
</tr>
<tr>
<td>(19)</td>
<td><strong>Fan</strong></td>
<td>767433-001</td>
</tr>
<tr>
<td>(20)</td>
<td><strong>Speaker assembly</strong></td>
<td>767452-001</td>
</tr>
<tr>
<td>(21)</td>
<td><strong>Battery, Li-ion</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4-cell, 44 Whr, 3.0 Ah</td>
<td>756744-001</td>
</tr>
<tr>
<td></td>
<td>4-cell, 40 Whr, 3.0 Ah</td>
<td>756746-001</td>
</tr>
<tr>
<td>(22)</td>
<td><strong>Base enclosure</strong></td>
<td>767428-001</td>
</tr>
<tr>
<td></td>
<td><strong>Service doors</strong>, includes:</td>
<td>767446-001</td>
</tr>
<tr>
<td>(23)</td>
<td>Small service door</td>
<td></td>
</tr>
<tr>
<td>(24)</td>
<td>Large service door</td>
<td></td>
</tr>
<tr>
<td>(25)</td>
<td><strong>Hard drive</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.5-TB, 5400-rpm, 9.5 mm</td>
<td>747375-001</td>
</tr>
<tr>
<td>Item Description</td>
<td>Spare part number</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>1-TB, 5400-rpm</td>
<td>778192-001</td>
<td></td>
</tr>
<tr>
<td>750-GB, 7200-rpm (HP 440 models only)</td>
<td>633252-001</td>
<td></td>
</tr>
<tr>
<td>750-GB, 5400-rpm</td>
<td>634250-001</td>
<td></td>
</tr>
<tr>
<td>500-GB, 5400-rpm</td>
<td>669299-001</td>
<td></td>
</tr>
<tr>
<td>500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD)(HP 440 models only)</td>
<td>732000-001</td>
<td></td>
</tr>
<tr>
<td>500-GB, 7200-rpm</td>
<td>703267-001</td>
<td></td>
</tr>
<tr>
<td>320-GB, 5400-rpm</td>
<td>622643-001</td>
<td></td>
</tr>
<tr>
<td><strong>Solid-state drive</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>512-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820581-001</td>
<td></td>
</tr>
<tr>
<td>512-GB Solid-state drive (HP 440 models only)</td>
<td>799466-001</td>
<td></td>
</tr>
<tr>
<td>128-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820579-001</td>
<td></td>
</tr>
<tr>
<td>128-GB Solid-state drive</td>
<td>767453-001</td>
<td></td>
</tr>
<tr>
<td>120-GB Solid-state drive (HP 440 models only)</td>
<td>768055-001</td>
<td></td>
</tr>
<tr>
<td><strong>(26) Optical drive</strong> (includes bracket, bezel, and screws)**</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blu-ray ROM DVD±RW SuperMulti DL Drive (HP 440 models only)</td>
<td>768051-001</td>
<td></td>
</tr>
<tr>
<td>DVD±RW SuperMulti DL Drive</td>
<td>767439-001</td>
<td></td>
</tr>
<tr>
<td>DVD-ROM drive</td>
<td>767440-001</td>
<td></td>
</tr>
</tbody>
</table>
# Display components

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Display bezel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For use in models with a webcam</td>
<td>767429-001</td>
</tr>
<tr>
<td></td>
<td>For use in models without a webcam</td>
<td>767430-001</td>
</tr>
<tr>
<td>(2)</td>
<td>Webcam module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HD</td>
<td>767457-001</td>
</tr>
<tr>
<td></td>
<td>HD, Lync</td>
<td>807958-001</td>
</tr>
<tr>
<td></td>
<td>Microphone module</td>
<td>773563-001</td>
</tr>
<tr>
<td>(3)</td>
<td>Display panel (raw)</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>HD</td>
<td>767448-001</td>
<td></td>
</tr>
<tr>
<td>HD+ (HP 440 models only)</td>
<td>768053-001</td>
<td></td>
</tr>
<tr>
<td>(4) WLAN antennas</td>
<td>Included in Display Rear Cover kit, 767427-001</td>
<td>not spared separately</td>
</tr>
<tr>
<td>(5) WWAN antennas</td>
<td>Included in Display Rear Cover kit, 767427-001</td>
<td>not spared separately</td>
</tr>
<tr>
<td>(6) Display Hinge Kit (includes left and right hinges)</td>
<td>767438-001</td>
<td></td>
</tr>
<tr>
<td>(7) Display/webcam cable assembly</td>
<td>Included in Cable Kit, 767431-001</td>
<td>767431-001 (Cable Kit)</td>
</tr>
<tr>
<td>(8) Display rear cover (includes wireless antennas)</td>
<td>767427-001</td>
<td></td>
</tr>
</tbody>
</table>

**Cable Kit**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable Kit</td>
<td></td>
<td>767431-001</td>
</tr>
<tr>
<td>(1) Battery connector cable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power board cable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(2) Display/webcam cable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(3) Display/webcam cable, EDP</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Mass storage devices

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hard drives</strong></td>
<td></td>
</tr>
<tr>
<td>1.5-TB, 5400-rpm, 9.5 mm</td>
<td>747375-001</td>
</tr>
<tr>
<td>1-TB, 5400-rpm</td>
<td>778192-001</td>
</tr>
<tr>
<td>750-GB, 7200-rpm</td>
<td>633252-001</td>
</tr>
<tr>
<td>750-GB, 5400-rpm</td>
<td>634250-001</td>
</tr>
<tr>
<td>500-GB, 5400-rpm</td>
<td>669299-001</td>
</tr>
<tr>
<td>500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD)</td>
<td>732000-001</td>
</tr>
<tr>
<td>500-GB, 7200-rpm</td>
<td>703267-001</td>
</tr>
<tr>
<td>320-GB, 5400-rpm</td>
<td>622643-001</td>
</tr>
<tr>
<td><strong>Solid-state drives</strong></td>
<td></td>
</tr>
<tr>
<td>512-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820581-001</td>
</tr>
<tr>
<td>512-GB Solid-state drive (HP 440 models only)</td>
<td>799466-001</td>
</tr>
<tr>
<td>128-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820579-001</td>
</tr>
<tr>
<td>128-GB Solid-state drive</td>
<td>767453-001</td>
</tr>
<tr>
<td>120-GB Solid-state drive (HP 440 models only)</td>
<td>768055-001</td>
</tr>
<tr>
<td><strong>Hard Drive Hardware Kit</strong> (includes hard drive bracket and screws; not illustrated)</td>
<td>767437-001</td>
</tr>
<tr>
<td><strong>Optical drives</strong> (include bezel, bracket, and screws)</td>
<td></td>
</tr>
<tr>
<td>Blu-ray ROM DVD±RW SuperMulti DL Drive (HP 440 models only)</td>
<td>768051-001</td>
</tr>
<tr>
<td>DVD±RW SuperMulti DL Drive</td>
<td>767439-001</td>
</tr>
<tr>
<td>DVD-ROM drive</td>
<td>767440-001</td>
</tr>
</tbody>
</table>

## Miscellaneous parts

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AC adapters</strong></td>
<td></td>
</tr>
<tr>
<td>65-W AC adapter</td>
<td>693711-001</td>
</tr>
<tr>
<td>65-W AC adapter for use in India</td>
<td>693710-001</td>
</tr>
<tr>
<td>45-W AC adapter</td>
<td>742737-001</td>
</tr>
<tr>
<td>45-W AC adapter, 7.4 mm, non-slim</td>
<td>744893-001</td>
</tr>
<tr>
<td><strong>Power cords, 1.83 m, 3-pin:</strong></td>
<td></td>
</tr>
<tr>
<td>For use in Argentina</td>
<td>490371-D01</td>
</tr>
<tr>
<td>For use in Brazil</td>
<td>490371-202</td>
</tr>
<tr>
<td>For use in Japan</td>
<td>490371-291</td>
</tr>
<tr>
<td>Description</td>
<td>Spare part number</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>For use in Thailand</td>
<td>490371-201</td>
</tr>
<tr>
<td>For use in the United Kingdom</td>
<td>490371-031</td>
</tr>
<tr>
<td>For use in the United States</td>
<td>490371-001</td>
</tr>
<tr>
<td>For use in Thailand</td>
<td>490371-201</td>
</tr>
<tr>
<td><strong>Power cords, 1.0 m, 3-pin:</strong></td>
<td></td>
</tr>
<tr>
<td>For use in Argentina</td>
<td>755530-001</td>
</tr>
<tr>
<td>For use in Brazil</td>
<td>755530-202</td>
</tr>
<tr>
<td>For use in Japan</td>
<td>755530-291</td>
</tr>
<tr>
<td>For use in Thailand</td>
<td>755530-201</td>
</tr>
<tr>
<td>For use in the United Kingdom</td>
<td>755530-031</td>
</tr>
<tr>
<td>For use in the United States</td>
<td>755530-001</td>
</tr>
<tr>
<td><strong>Rubber Kit (includes rubber base enclosure screw covers and mylar display bezel screw covers)</strong></td>
<td>767450-001</td>
</tr>
<tr>
<td><strong>Screw Kit</strong></td>
<td>767451-001</td>
</tr>
</tbody>
</table>
Tools required

You will need the following tools to complete the removal and replacement procedures:

- Flat-bladed screwdriver
- Phillips P0 and P1 screwdrivers
- Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and assembly procedures.

**NOTE:** As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) away from the work area to prevent damage.

Plastic parts

**CAUTION:** Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
Cables and connectors

⚠️ **CAUTION:** When servicing the computer, be sure that cables are placed in their proper locations during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily.

Drive handling

⚠️ **CAUTION:** Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label the package “FRAGILE.”
Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. Or the device may function normally for a while, and then degrade in the internal layers, reducing its life expectancy.

⚠️ CAUTION: To prevent damage to the computer when you are removing or installing internal components, observe these precautions:

- Keep components in their electrostatic-safe containers until you are ready to install them.
- Use nonmagnetic tools.
- Before touching an electronic component, discharge static electricity by using the guidelines described in this section.
- Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
- If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

⚠️ CAUTION: A product can be degraded by as little as 700 V.

<table>
<thead>
<tr>
<th>Event</th>
<th>10%</th>
<th>40%</th>
<th>55%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walking across carpet</td>
<td>35,000 V</td>
<td>15,000 V</td>
<td>7,500 V</td>
</tr>
<tr>
<td>Walking across vinyl floor</td>
<td>12,000 V</td>
<td>5,000 V</td>
<td>3,000 V</td>
</tr>
<tr>
<td>Motions of bench worker</td>
<td>6,000 V</td>
<td>800 V</td>
<td>400 V</td>
</tr>
<tr>
<td>Removing DIPS from plastic tube</td>
<td>2,000 V</td>
<td>700 V</td>
<td>400 V</td>
</tr>
<tr>
<td>Removing DIPS from vinyl tray</td>
<td>11,500 V</td>
<td>4,000 V</td>
<td>2,000 V</td>
</tr>
<tr>
<td>Removing DIPS from Styrofoam</td>
<td>14,500 V</td>
<td>5,000 V</td>
<td>3,500 V</td>
</tr>
<tr>
<td>Removing bubble pack from PCB</td>
<td>26,500 V</td>
<td>20,000 V</td>
<td>7,000 V</td>
</tr>
<tr>
<td>Packing PCBs in foam-lined box</td>
<td>21,000 V</td>
<td>11,000 V</td>
<td>5,000 V</td>
</tr>
</tbody>
</table>
Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

- To avoid hand contact, transport products in static-safe tubes, bags, or boxes.
- Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
- Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
- Place items on a grounded surface before removing items from their containers.
- Always be properly grounded when touching a component or assembly.
- Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.
- Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment used for moving materials is wired to ground and that proper materials are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

- Cover the workstation with approved static-shielding material.
- Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and equipment.
- Use conductive field service tools, such as cutters, screwdrivers, and vacuums.
- When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials.
- Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam.
- Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items only at static-free workstations.
- Avoid contact with pins, leads, or circuitry.
- Turn off power and input signals before inserting or removing connectors or test equipment.
Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

- When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a wrist strap.

- When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at standing workstations and are compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the operator and ground. To be effective, the conductive strips must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

- Antistatic tapes
- Antistatic smocks, aprons, and sleeve protectors
- Conductive bins and other assembly or soldering aids
- Nonconductive foam
- Conductive tabletop workstations with ground cords of one megohm resistance
- Static-dissipative tables or floor mats with hard ties to the ground
- Field service kits
- Static awareness labels
- Material-handling packages
- Nonconductive plastic bags, tubes, or boxes
- Metal tote boxes
- Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

<table>
<thead>
<tr>
<th>Material</th>
<th>Use</th>
<th>Voltage protection level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antistatic plastic</td>
<td>Bags</td>
<td>1,500 V</td>
</tr>
<tr>
<td>Carbon-loaded plastic</td>
<td>Floor mats</td>
<td>7,500 V</td>
</tr>
<tr>
<td>Metallized laminate</td>
<td>Floor mats</td>
<td>5,000 V</td>
</tr>
</tbody>
</table>
5 Removal and replacement procedures for Customer Self-Repair parts

⚠️ **CAUTION:** The Customer Self-Repair program is not available in all locations. Installing a part not supported by the Customer Self-Repair program may void your warranty. Check your warranty to determine if Customer Self-Repair is supported in your location.

🔍 **NOTE:** HP continually improves and changes product parts. For complete and current information on supported parts for your computer, go to [http://partsurfer.hp.com](http://partsurfer.hp.com), select your country or region, and then follow the on-screen instructions.

### Component replacement procedures

🔍 **NOTE:** Please read and follow the procedures described here to access and replace Customer Self-Repair parts successfully.

🔍 **NOTE:** Details about your computer, including model, serial number, product key, and length of warranty, are on the service tag at the bottom of your computer. See [Labels on page 19](#) for details.

This chapter provides removal and replacement procedures for Customer Self-Repair parts.

There are as many as 16 screws that must be removed, replaced, or loosened when servicing Customer Self-Repair parts. Make special note of each screw size and location during removal and replacement.
Battery

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-cell, 44 WHr, 3.0 Ah Li-ion battery</td>
<td>756744-001</td>
</tr>
<tr>
<td>4-cell, 40 WHr, 3.0 Ah Li-ion battery</td>
<td>756746-001</td>
</tr>
</tbody>
</table>

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.

To remove the battery:

⚠️ **CAUTION**: Removing a battery that is the sole power source for the computer can cause loss of information. To prevent loss of information, save your work and shut down the computer through Windows before removing the battery.

1. Turn the computer upside down on a flat surface.
2. Slide the battery lock latch (1), and then slide the battery release latch (2) to release the battery.
3. Tilt the battery upward (3) and remove it from the computer (4).
**Service door**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service doors (includes large and small service door)</td>
<td>767446-001</td>
</tr>
</tbody>
</table>

Before removing the service door, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).

To remove the service door:

1. With the battery bay away from you, loosen the service door screw (1). The service door screw secures both service doors.
2. Slide the larger service door away from the battery bay (2) to remove it.

**NOTE:** The larger service door provides access to the hard drive and memory modules.
3. Slide the smaller service door away from the battery bay (3) to release it, and then lift the service door (4) to remove it.

**NOTE:** The smaller service door provides access to the wireless modules, optical drive security screw, and keyboard screws. You must remove the large service door to remove the small service door.
### Hard drive

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hard drives</strong></td>
<td></td>
</tr>
<tr>
<td>1.5-TB, 5400-rpm, 9.5 mm</td>
<td>747375-001</td>
</tr>
<tr>
<td>1-TB, 5400-rpm</td>
<td>778192-001</td>
</tr>
<tr>
<td>750-GB, 7200-rpm (HP 440 models only)</td>
<td>633252-001</td>
</tr>
<tr>
<td>750-GB, 5400-rpm, 7 mm hard drive</td>
<td>634250-001</td>
</tr>
<tr>
<td>500-GB, 5400-rpm</td>
<td>669299-001</td>
</tr>
<tr>
<td>500-GB, 5400-rpm, 7 mm, hybrid (8-GB SSD)</td>
<td>732000-001</td>
</tr>
<tr>
<td>500-GB, 7200-rpm</td>
<td>703267-001</td>
</tr>
<tr>
<td>320-GB, 5400-rpm</td>
<td>622643-001</td>
</tr>
<tr>
<td><strong>Solid-state drives</strong></td>
<td></td>
</tr>
<tr>
<td>512-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820581-001</td>
</tr>
<tr>
<td>512-GB Solid-state drive (HP 440 models only)</td>
<td>799466-001</td>
</tr>
<tr>
<td>128-GB Solid-state drive, TLC (HP 440 models only)</td>
<td>820579-001</td>
</tr>
<tr>
<td>128-GB Solid-state drive</td>
<td>767453-001</td>
</tr>
<tr>
<td>120-GB Solid-state drive (HP 440 models only)</td>
<td>768055-001</td>
</tr>
</tbody>
</table>

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the large service door (see Service door on page 37).

To remove a hard drive:

1. Remove the 4 Phillips PM2.5×4.0 screws (1) that secure the hard drive to the chassis.
2. Slide the hard drive (2) away from the center of the computer to disengage it from the connector.
3. Pull the plastic tab (3) to remove the hard drive from the bay.

4. To remove the hard drive cover and bracket from the hard drive, lift the Mylar cover up off the drive (1), remove the 4 Phillips PM3.0×3.0 screws (2) that secure the bracket to the drive, and then lift the bracket up and off the hard drive (3).

Reverse this procedure to install a hard drive.
**Memory modules**

**NOTE:** Primary and expansion memory is installed in a stacked configuration in the bottom of the computer.
If only one memory module is installed, it must be installed in the bottom socket.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-GB (PC3L-12800, 1600-MHz, DDR3L)</td>
<td>691739-001</td>
</tr>
<tr>
<td>4-GB (PC3L-12800, 1600-MHz, DDR3L)</td>
<td>691740-001</td>
</tr>
<tr>
<td>8-GB (PC3L-12800, 1600-MHz, DDR3L)</td>
<td>693374-001</td>
</tr>
</tbody>
</table>

**Update BIOS before adding memory modules**

Before adding new memory, make sure you update the computer to the latest BIOS.

**CAUTION:** Failure to update the computer to the latest BIOS prior to installing new memory may result in various system problems.

To update BIOS:

2. Click **Support & Drivers > click Drivers & Software**.
3. In the **Enter a product name/number** box, type the computer model information, and then click **Search**.
4. Click the link for the computer model.
5. Select the operating system, and then click **Next**.
6. Under **Step 2: Select a Download**, click the **BIOS** link.
7. Click the link for the most recent BIOS.
8. Click the **Download** button, and then follow the on-screen instructions.

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see **Battery on page 36**).
5. Remove the large service door (see **Service door on page 37**).
6. Remove the memory module:
   1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory module. (The edge of the module opposite the slot rises away from the computer.)
2. Remove the memory module (2) by pulling the module away from the slot at an angle.

**NOTE:** Memory modules are designed with a notch to prevent incorrect insertion into the memory module slot.

**NOTE:** The computer uses two memory sockets. The top socket houses the expansion memory module and the bottom socket houses the primary memory module. The removal procedure is the same for both memory sockets.

Reverse this procedure to install a memory module.
### Optical drive

**NOTE:** All optical drive spare part kits include an optical drive bezel, bracket, and screws.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-ROM drive</td>
<td>767440-001</td>
</tr>
<tr>
<td>Blu-ray ROM DVD±RW SuperMulti DL Drive (HP 440 models only)</td>
<td>768051-001</td>
</tr>
<tr>
<td>DVD±RW SuperMulti DL Drive</td>
<td>767439-001</td>
</tr>
</tbody>
</table>

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see [Battery on page 36](#)).
5. Remove both service doors (see [Service door on page 37](#)).

Remove the optical drive:

1. Remove the Phillips PM2.5×6.0 screw (1) that secures the optical drive to the computer.
2. Push the optical drive tab (2) to release the optical drive from the computer.
3. Remove the optical drive (3) from the computer.
4. To remove the bracket from the optical drive, remove the Phillips PM2.0×3.0 screw (1) that secures the bracket to the drive, and then remove the bracket from the drive (2).

Reverse this procedure to install an optical drive.
**WLAN/Bluetooth combo card**

The computer uses a card that provides both WLAN and Bluetooth functionality.

The WLAN module and WWAN module are not interchangeable.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Atheros AR9485 802.11b/g/n 1x1 WiFi Adapter</td>
<td>675794-001</td>
</tr>
<tr>
<td>Realtek RTL8188EE 802.11bgn Wi-Fi Adapter</td>
<td>709848-001</td>
</tr>
<tr>
<td>Intel Dual Band Wireless-AC 3160 802.11 ac 1x1 WiFi + BT 4.0 combo adapter</td>
<td>710662-001</td>
</tr>
<tr>
<td>Broadcom BCM943228HM8 802.11 abgn 2x2 Wi-Fi Adapter + Broadcom Bluetooth 4.0 Adapter</td>
<td>730668-001</td>
</tr>
<tr>
<td>Broadcom BCM43142 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter</td>
<td>753076-001</td>
</tr>
<tr>
<td>Realtek RT8723BE 802.11 bgn 1x1 Wi-Fi + BT4.0 combo adapter</td>
<td>753077-001</td>
</tr>
<tr>
<td>Intel Dual Band Wireless-AC 7260 802.11 ac 2x2 WiFi + Intel Dual Band Wireless-AC 7260 BT 4.0 combo adapter</td>
<td>756753-001</td>
</tr>
</tbody>
</table>

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.

4. Remove the battery (see **Battery on page 36**).

5. Remove both service doors (see **Service door on page 37**).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

   **NOTE:** The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable connects to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WLAN module to the computer. (The edge of the module opposite the slot rises away from the computer.)
3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

**NOTE:** WLAN modules are designed with a notch to prevent incorrect insertion.

**NOTE:** If the WLAN antennas are not connected to the terminals on the WLAN module, the protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
The WLAN module and WWAN module are not interchangeable.

The WWAN module is available on select models only.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP lt4112 LTE/HSPA+ Gobi 4G Module</td>
<td>740011-001</td>
</tr>
<tr>
<td>HP hs3110 HSPA+ Mobile Broadband Module</td>
<td>748599-001</td>
</tr>
</tbody>
</table>

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove both service doors (see Service door on page 37).

Remove the WWAN module:

1. Position the computer upside-down.
2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

   **NOTE:** The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer. (The edge of the module opposite the slot rises away from the computer.)
4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

**NOTE:** WWAN modules are designed with a notch to prevent incorrect insertion.

**NOTE:** If the WWAN antennas are not connected to the terminals on the WWAN module, the protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
In this section, the first table provides the main spare part number for the keyboards. The second table provides the country codes.

### Keyboard

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard, no backlight</td>
<td>767470-xxx</td>
</tr>
<tr>
<td>Keyboard, backlit</td>
<td>767476-xxx</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For use in country or region</th>
<th>Spare part number</th>
<th>For use in country or region</th>
<th>Spare part number</th>
<th>For use in country or region</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Belgium</td>
<td>-A41</td>
<td>India</td>
<td>-D61</td>
<td>Saudi Arabia</td>
<td>-171</td>
</tr>
<tr>
<td>Brazil</td>
<td>-201</td>
<td>Israel</td>
<td>-BB1</td>
<td>Slovenia</td>
<td>-BA1</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>-261</td>
<td>Italy</td>
<td>-061</td>
<td>South Korea</td>
<td>-AD1</td>
</tr>
<tr>
<td>Canada</td>
<td>-DB1</td>
<td>Japan</td>
<td>-291</td>
<td>Spain</td>
<td>-071</td>
</tr>
<tr>
<td>Czech Republic and Slovakia</td>
<td>-FL1</td>
<td>Latin America</td>
<td>-161</td>
<td>Sweden and Finland</td>
<td>-B71</td>
</tr>
<tr>
<td>Denmark</td>
<td>-081</td>
<td>The Netherlands</td>
<td>-B31</td>
<td>Switzerland</td>
<td>-BG1</td>
</tr>
<tr>
<td>Denmark, Finland, and Norway</td>
<td>-DH1</td>
<td>Northern Africa</td>
<td>-FP1</td>
<td>Taiwan</td>
<td>-AB1</td>
</tr>
<tr>
<td>France</td>
<td>-051</td>
<td>Norway</td>
<td>-091</td>
<td>Thailand</td>
<td>-281</td>
</tr>
<tr>
<td>Germany</td>
<td>-041</td>
<td>Portugal</td>
<td>-131</td>
<td>Turkey</td>
<td>-141</td>
</tr>
<tr>
<td>Greece</td>
<td>-151</td>
<td>Romania</td>
<td>-271</td>
<td>United Kingdom</td>
<td>-031</td>
</tr>
<tr>
<td>Hungary</td>
<td>-211</td>
<td>Russia</td>
<td>-251</td>
<td>United States</td>
<td>-001</td>
</tr>
<tr>
<td>Iceland</td>
<td>-DD1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove both service doors (see Service door on page 37).

Remove the keyboard:

1. Remove the 2 Phillips PM2.5×6.0 screws that secure the keyboard to the computer.
2. Position the computer upright with the front toward you.
3. Open the computer as far as possible.
4. Slide the keyboard slightly downward toward the palm rest to disengage the top of the keyboard from the top cover.
5. Rotate the top of the keyboard upward (1), and then lift the keyboard up at an angle (2) to disengage the tabs at the bottom of the keyboard.

**NOTE:** A cable connects the bottom of the keyboard to the system board. Make sure not to prematurely pull the keyboard cable out of the system board connector.

6. Rotate the keyboard until it rests on the palm rest (1).
7. Disconnect the keyboard cable by lifting the keyboard connector latch (2), and then disconnect the keyboard cable from the system board (3).

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
6  Removal and replacement procedures for Authorized Service Provider parts

⚠️ CAUTION: Components described in this chapter should only be accessed by an authorized service provider. Accessing these parts can damage the computer or void the warranty.

⚠️ NOTE: HP continually improves and changes product parts. For complete and current information on supported parts for your computer, go to [http://partsurfer.hp.com](http://partsurfer.hp.com), select your country or region, and then follow the on-screen instructions.

Component replacement procedures

⚠️ NOTE: Details about your computer, including model, serial number, product key, and length of warranty, are on the service tag at the bottom of your computer. See [Labels on page 19](#) for details.

This chapter provides removal and replacement procedures for Authorized Service Provider only parts. There are as many as 48 screws that must be removed, replaced, or loosened when servicing Authorized Service Provider only parts. Make special note of each screw size and location during removal and replacement.

Top cover

⚠️ NOTE: Top cover spare part kits include the touchpad assembly.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top cover for use in models with a fingerprint reader (includes touchpad)</td>
<td>767454-001</td>
</tr>
<tr>
<td>Top cover for use in models without a fingerprint reader (includes touchpad) (HP 440 models only)</td>
<td>773564-001</td>
</tr>
</tbody>
</table>

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the following components:
   a. Battery (see [Battery on page 36](#)).
   b. Service doors (see [Service door on page 37](#)).
   c. Hard drive ([Hard drive on page 39](#)).
   d. Optical drive ([Optical drive on page 43](#)).
   e. Keyboard (see [Keyboard on page 49](#)).
Remove the top cover:

1. Position the computer upside-down with the front toward you.
2. Remove the 6 rubber screw covers (1) and 8 Torx T8M2.5×6.0 screws (2) that secure the top cover to the computer.

3. Remove the 7 Phillips PM2.5×3.0 screws (1) and the 3 Phillips PM2.0×2.5 screws (2) that secure the top cover to the computer.

4. Position the computer upright and open it as far as possible.
5. Disconnect the following cables from the system board:
   - (1): Card reader board cable
   - (2): Power button board cable
   - (3): Function board cable
6. Remove the 3 Torx T8M2.5×6.0 screws (6) from the top of the computer.

7. Pry the top cover off the computer to disengage it.

**NOTE:** Begin by attempting to pry the top cover loose near the optical drive.

8. Lift the top of the top cover (1), and lift the top cover up and remove it from the computer (2).

Reverse this procedure to install the top cover.
RTC battery, HP 445 models

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTC battery</td>
<td>759981-001</td>
</tr>
</tbody>
</table>

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. Keyboard (see Keyboard on page 49)
   e. Top cover (see Top cover on page 53)

Remove the RTC battery:

1. Using a flat tool, pry the battery out of the socket (1).
2. Remove the battery from the socket (2).

Reverse this procedure to install the RTC battery.
## Speaker assembly

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaker assembly</td>
<td>767452-001</td>
</tr>
</tbody>
</table>

**NOTE:** You must remove the left speaker to remove to function board cable.

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Keyboard (see Keyboard on page 49)
   c. Hard drive (Hard drive on page 39)
   d. Optical drive (Optical drive on page 43)
   e. Top cover (see Top cover on page 53)

Remove the speaker assembly:

1. Position the top cover upside-down.
2. Remove the 2 Phillips PM2.0×3.0 broadhead screws (1) that secure the speakers to the computer.
3. Slide the speakers toward each other to disengage them from the top cover (2).
4. Remove the speakers from the top cover (3).

Reverse this procedure to install the speaker assembly.
Before removing the fingerprint reader assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Keyboard (see Keyboard on page 49)
   c. Hard drive (Hard drive on page 39)
   d. Optical drive (Optical drive on page 43)
   e. Top cover (see Top cover on page 53)

Remove the fingerprint reader assembly:

1. Position the top cover upside-down.
2. Slide the bracket toward the bottom of the top cover (1), and then lift it off the top cover (2).
3. Remove the fingerprint reader board and cable assembly from the top cover (3).

Reverse this procedure to install the fingerprint reader assembly.

**Power button board**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power button board assembly</td>
<td>767442-001</td>
</tr>
</tbody>
</table>

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37)
   b. Keyboard (see Keyboard on page 49)
   c. Hard drive (Hard drive on page 39)
d. Optical drive (Optical drive on page 43)
e. Top cover (see Top cover on page 53)

Remove the power button board:

1. Position the top cover upside-down.
2. Remove the Phillips PM2.0×3.0 screw (1) that secures the power button board to the top cover.
3. Slide the board upward to disengage it from the tabs (2).
4. Lift the board up to remove it from the top cover (3), while guiding the cable through the hole in the top cover (4).

Reverse this procedure to install the power button board.
Before removing the function board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37)
   b. Keyboard (see Keyboard on page 49)
   c. Hard drive (Hard drive on page 39)
   d. Optical drive (Optical drive on page 43)
   e. Top cover (see Top cover on page 53)

Remove the function board:

1. Position the top cover upside-down.
2. Remove the Phillips PM2.0×3.0 screw (1) that secures the function board to the top cover.
3. Slide the board toward the top of the top cover (2), and then lift it off the top cover (3).
4. On the front of the top cover, pull the cable to disengage it from the adhesive that secures it, and then pull the cable through the hole in the top cover (4).

5. Remove the function board from the top cover.
Reverse this procedure to install the function board.

Card reader board

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card reader board for use in HP 440 models</td>
<td>768052-001</td>
</tr>
<tr>
<td>Card reader board for use in HP 440 models</td>
<td>767445-001</td>
</tr>
</tbody>
</table>

Before removing the card reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
a. Service doors (see Service door on page 37).
b. Keyboard (see Keyboard on page 49).
c. Hard drive (Hard drive on page 39).
d. Optical drive (Optical drive on page 43).
e. Top cover (see Top cover on page 53).

Remove the card reader board:

**NOTE:** Before you remove the card reader, make sure nothing (memory card or plastic insert) in installed.

1. Position the top cover upside-down.
2. Disconnect the cable from the board (1).
3. Remove the two Phillips PM2.5 × 4.0 screws (2) that secure the card reader board to the computer.
4. Remove the card reader board from the top cover (3).

Reverse this procedure to install the card reader board.
USB/audio board

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB/audio board</td>
<td>767444-001</td>
</tr>
</tbody>
</table>

Before removing the USB/audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Keyboard (see Keyboard on page 49).
   c. Hard drive (Hard drive on page 39).
   d. Optical drive (Optical drive on page 43).
   e. Top cover (see Top cover on page 53).

Remove the USB/audio board:

1. Position the top cover upside-down.
2. Remove the Phillips PM2.5×4.0 screw (1) that secures the USB/audio board to the computer.
3. Disconnect the cable from the board (2).
4. Lift the board off the top cover (3).

Reverse this procedure to install the USB/audio board.
Before removing the touchpad button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Keyboard (see Keyboard on page 49).
   c. Hard drive (Hard drive on page 39).
   d. Optical drive (Optical drive on page 43).
   e. Top cover (see Top cover on page 53).

Remove the touchpad button board:

1. Position the top cover upside-down.
2. Disconnect the cable from the touchpad (1).
3. Disconnect the cable from the card reader board (2).
4. Remove the Phillips PM2.0×3.0 screw (3) that secures the button board to the top cover.
5. Lift the right side of the touchpad button board up, and then pull it to the right to remove it from the slot (4).
6. Lift the touchpad button board off the top cover (5).

Reverse this procedure to install the touchpad board.
**Fan**

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fan</td>
<td>767433-001</td>
</tr>
</tbody>
</table>

**NOTE:** To properly ventilate the computer, allow at least **7.6 cm** (3.0 in) of clearance on the left side of the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to turn on automatically when high temperature conditions exist. These conditions are affected by high external temperatures, system power consumption, power management/battery conservation configurations, battery fast charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then unplugging the AC adapter from the computer.
4. Remove the battery (see [Battery on page 36](#)), and then remove the following components:
   a. Service doors (see [Service door on page 37](#)).
   b. Hard drive ([Hard drive on page 39](#)).
   c. Optical drive ([Optical drive on page 43](#)).
   d. Keyboard (see [Keyboard on page 49](#)).
   e. Top cover (see [Top cover on page 53](#)).

To remove the fan:

1. Disconnect the fan cable (1) from the system board.
2. Lift the fan from the computer (2).

Reverse this procedure to install the fan.
Battery connector cable

The battery connector cable is included in the Cable Kit, spare part number 767431-001.

Before removing the battery connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (Hard drive on page 39)
   c. Optical drive (Optical drive on page 43)
   d. Keyboard (see Keyboard on page 49)
   e. Top cover (see Top cover on page 53)

Remove the battery connector cable:

1. Disconnect the battery connector cable from the system board (1).
2. Remove the cable from the clip in the computer (2).
3. Remove the 2 Phillips PM2.5×4.0 screws that secure the battery connector cable to the computer (3).
4. Remove the battery connector cable from the computer (4).

Reverse this procedure to install the battery connector cable.
All system boards use the following part numbers:

xxxxxxx-001: Windows 7 or non-Windows operating systems

xxxxxxx-501: Windows 8.1 Standard operating system

xxxxxxx-601: Windows 8.1 or Windows 10 operating system

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel i7-5500U processor; 2-GB discrete graphics memory</td>
<td>798508-xxx</td>
</tr>
<tr>
<td>Intel i5-5300U processor; 2-GB discrete graphics memory</td>
<td>798507-xxx</td>
</tr>
<tr>
<td>Intel i5-5200U processor; 2-GB discrete graphics memory</td>
<td>798506-xxx</td>
</tr>
<tr>
<td>Intel i3-5020U processor; 2-GB discrete graphics memory</td>
<td>822646-xxx</td>
</tr>
<tr>
<td>Intel i3-5010U processor; 2-GB discrete graphics memory</td>
<td>798505-xxx</td>
</tr>
<tr>
<td>Intel i3-5005U processor; 2-GB discrete graphics memory</td>
<td>798504-xxx</td>
</tr>
<tr>
<td>Intel i5-5200U processor; 1-GB discrete graphics memory</td>
<td>798503-xxx</td>
</tr>
<tr>
<td>Intel i3-5020U processor; 1-GB discrete graphics memory</td>
<td>822645-xxx</td>
</tr>
<tr>
<td>Intel i3-5010U processor; 1-GB discrete graphics memory</td>
<td>798502-xxx</td>
</tr>
<tr>
<td>Intel i3-5005U processor; 1-GB discrete graphics memory</td>
<td>798501-xxx</td>
</tr>
<tr>
<td>Intel i7-5500U processor; UMA graphics memory</td>
<td>798497-xxx</td>
</tr>
<tr>
<td>Intel i5-5300U processor; UMA graphics memory</td>
<td>798496-xxx</td>
</tr>
<tr>
<td>Intel i5-5200U processor; UMA graphics memory</td>
<td>798495-xxx</td>
</tr>
<tr>
<td>Intel i5-5200U processor; UMA graphics memory; WWAN models</td>
<td>798500-xxx</td>
</tr>
<tr>
<td>Intel i3-5020U processor; UMA graphics memory</td>
<td>822643-xxx</td>
</tr>
<tr>
<td>Intel i3-5020U processor; UMA graphics memory; WWAN models</td>
<td>822644-xxx</td>
</tr>
<tr>
<td>Intel i3-5010U processor; UMA graphics memory</td>
<td>798494-xxx</td>
</tr>
<tr>
<td>Intel i3-5010U processor; UMA graphics memory; WWAN models</td>
<td>798499-xxx</td>
</tr>
<tr>
<td>Intel i3-5005U processor; UMA graphics memory</td>
<td>798493-xxx</td>
</tr>
<tr>
<td>Intel i3-5005U processor; UMA graphics memory; WWAN models</td>
<td>798498-xxx</td>
</tr>
<tr>
<td>Intel Celeron 3215U processor; UMA graphics memory</td>
<td>825082-xxx</td>
</tr>
<tr>
<td>Intel Celeron 3205U processor; UMA graphics memory</td>
<td>798492-xxx</td>
</tr>
<tr>
<td>Intel i7-4510U processor; 2-GB discrete graphics memory</td>
<td>768078-xxx</td>
</tr>
<tr>
<td>Intel i5-4310U processor; 2-GB discrete graphics memory</td>
<td>768073-xxx</td>
</tr>
<tr>
<td>Intel i5-4210U processor; 2-GB discrete graphics memory</td>
<td>768072-xxx</td>
</tr>
<tr>
<td>Intel i3-4030U processor; 2-GB discrete graphics memory</td>
<td>768071-xxx</td>
</tr>
<tr>
<td>Intel i3-4005U processor; 2-GB discrete graphics memory</td>
<td>783995-xxx</td>
</tr>
</tbody>
</table>
Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. Keyboard (see Keyboard on page 49)
   e. Top cover (see Top cover on page 53)

When replacing the system board, be sure to remove the following components from the defective system board and install on the replacement system board:

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intel i5-4210U processor; 1-GB discrete graphics memory</td>
<td>768069-xxx</td>
</tr>
<tr>
<td>Intel i3-4030U processor; 1-GB discrete graphics memory</td>
<td>768068-xxx</td>
</tr>
<tr>
<td>Intel i5-4210U processor; UMA graphics memory; WWAN models</td>
<td>768064-xxx</td>
</tr>
<tr>
<td>Intel i7-4510U processor; UMA graphics memory</td>
<td>768060-xxx</td>
</tr>
<tr>
<td>Intel i5-4310U processor; UMA graphics memory</td>
<td>768059-xxx</td>
</tr>
<tr>
<td>Intel i5-4210U processor; UMA graphics memory; Non-WWAN models</td>
<td>768058-xxx</td>
</tr>
<tr>
<td>Intel i3-4030U processor; UMA graphics memory; WWAN models</td>
<td>768063-xxx</td>
</tr>
<tr>
<td>Intel i3-4030U processor; UMA graphics memory; Non-WWAN models</td>
<td>768057-xxx</td>
</tr>
<tr>
<td>Intel i3-4005U processor; UMA graphics memory</td>
<td>783994-xxx</td>
</tr>
<tr>
<td>Intel Celeron 2957U processor; UMA graphics memory</td>
<td>768056-xxx</td>
</tr>
<tr>
<td>AMD A10-7300 processor; 2 GB discrete graphics memory</td>
<td>767468-xxx</td>
</tr>
<tr>
<td>AMD A8-7100 processor; 2 GB discrete graphics memory</td>
<td>767467-xxx</td>
</tr>
<tr>
<td>AMD A6-7050B processor; 2 GB discrete graphics memory</td>
<td>767466-xxx</td>
</tr>
<tr>
<td>AMD A10-7300 processor; 1 GB discrete graphics memory</td>
<td>767464-xxx</td>
</tr>
<tr>
<td>AMD A8-7100 processor; 1 GB discrete graphics memory</td>
<td>767463-xxx</td>
</tr>
<tr>
<td>AMD A6-7050B processor; 1 GB discrete graphics memory</td>
<td>767462-xxx</td>
</tr>
<tr>
<td>AMD A10-7300 processor; UMA graphics memory</td>
<td>767460-xxx</td>
</tr>
<tr>
<td>AMD A8-7100 processor; UMA graphics memory</td>
<td>767459-xxx</td>
</tr>
<tr>
<td>AMD A6-7050B processor; UMA graphics memory</td>
<td>767458-xxx</td>
</tr>
</tbody>
</table>
Remove the system board:

1. Position the computer upright with the front toward you.

2. Disconnect the following cables from the system board:
   - (1) Power connector cable
   - (2) Display cable
   - (3) Battery connector cable

3. Remove the 3 Phillips PM2.5×4.0 screws (1) that secure the system board and the broadhead Phillips PM2.0×3.0 screw (2) that secures the optical drive extension board to the computer.

4. Lift the right side of the system board up at an angle (3).
5. Pull the system board up and toward the right to remove it from the computer (4).

Reverse this procedure to install the system board.
**Optical drive extension board**

You must remove the system board to remove the optical drive extension board.

Before removing the optical drive extension board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. WLAN module (see WLAN/Bluetooth combo card on page 45)
   e. WWAN module (see WWAN module on page 47)
   f. Keyboard (see Keyboard on page 49)
   g. Top cover (see Top cover on page 53)
   h. System board (see System board on page 72)

Remove the optical drive extension board:

1. Position the system board upright.
2. Pull the optical drive extension board straight away from the side of the system board.

Reverse this procedure to install the optical drive extension board.
RTC battery, HP 440 models

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTC battery</td>
<td>759981-001</td>
</tr>
</tbody>
</table>

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. Keyboard (see Keyboard on page 49)
   e. Top cover (see Top cover on page 53)
   f. System board (see System board on page 72)

Remove the RTC battery:

1. Position the system board upside-down.
2. Disconnect the cable from the system board connector (1).
3. Lift the battery to disengage it from the tape that secures it to the system board (2).

Reverse this procedure to install the RTC battery.
Heat sink assembly

All heat sink assembly spare part kits include replacement thermal material.

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heat sink assembly for use in HP 440 (Intel) models:</strong></td>
<td></td>
</tr>
<tr>
<td>For use in models with UMA graphics</td>
<td>768048-001</td>
</tr>
<tr>
<td>For use in models with discrete graphics and all processors except for the Intel i7-4558U</td>
<td>768050-001</td>
</tr>
<tr>
<td>For use in models with discrete graphics and an Intel i5-4210U processor</td>
<td>768049-001</td>
</tr>
<tr>
<td><strong>Heat sink assembly for use in HP 445 (AMD) models:</strong></td>
<td></td>
</tr>
<tr>
<td>For use in models with UMA graphics</td>
<td>767435-001</td>
</tr>
<tr>
<td>For use in models with discrete graphics</td>
<td>767434-001</td>
</tr>
</tbody>
</table>

Before removing the heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. WLAN module (see WLAN/Bluetooth combo card on page 45)
   e. WWAN module (see WWAN module on page 47)
   f. Keyboard (see Keyboard on page 49)
   g. Top cover (see Top cover on page 53)
   h. System board (see System board on page 72)

Remove the heat sink assembly:

1. Position the system board upside-down.
2. Models are available with either UMA or discrete graphics. The heat sink on discrete models includes 2 additional screws. Refer to the following steps that match your model:

   **Discrete models:**
   a. To remove the discrete heat sink assembly, in the order indicated on the heat sink, loosen the 6 captive Phillips screws (1) that secure the heat sink to the system board.
b. Lift the heat sink from the system board (2).

**NOTE:** For discrete models, thoroughly clean thermal material from the surfaces of the system board components (1)(3) and the heat sink (2)(4) each time you remove the heat sink. All heat sink and processor spare part kits include thermal material.

**UMA models:**

a. To remove the UMA heat sink assembly, in the order indicated on the heat sink, loosen the 4 captive Phillips screws (1) that secure the heat sink to the system board.
b. Lift the heat sink from the system board (2).

**NOTE:** For UMA models, thoroughly clean thermal material from the surfaces of the system board component (1) and the heat sink (2) each time you remove the heat sink. All heat sink and processor spare part kits include thermal material.

Reverse this procedure to install the heat sink assembly.
Display assembly

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display panel assembly, touch screen</td>
<td>782118-001</td>
</tr>
<tr>
<td>Display panel assembly, touch screen, two antennas</td>
<td>782531-001</td>
</tr>
</tbody>
</table>

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 36).

5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Hard drive (see Hard drive on page 39)
   c. Optical drive (see Optical drive on page 43)
   d. WLAN module (see WLAN/Bluetooth combo card on page 45)
   e. WWAN module (see WWAN module on page 47)
   f. Keyboard (see Keyboard on page 49)
   g. Top cover (see Top cover on page 53)

Remove the display assembly:

1. Position the computer upside down.
2. Pull the antenna cables through from the bottom of the computer. Position the computer upside down, and then remove the cables from the clips near the wireless modules (1), pulling the cables (2) through the holes (3) in the computer.

3. Position the computer upright and open.

4. Disconnect the display cable from the system board (1).

5. Remove the WLAN antennas and WWAN antennas (if equipped) from the routing path along the base of the computer (2).

6. Place the computer upright and open as far as possible.
7. Remove the 5 Phillips PM2.5×4.0 screws (1) from the display hinges.

8. Lift the display assembly straight up and remove it (2).

⚠️ **CAUTION:** When installing the display assembly, be sure that the wireless antenna cables are routed and arranged properly.

Failure to properly route the antennas can result in degradation of the computer’s wireless performance.

9. If you need to remove the display bezel, remove the 2 mylar screw covers (1) and the 2 Phillips PM2.0×3.0 screws (2) in the bottom corners of the display bezel.

10. Flex the top (3) of the bezel, the inside edges of the left and right sides (4), and then the bottom (5) of the bezel until it disengages from the display enclosure.

💡 **NOTE:** Make sure the hinges are not bent (see hinge position in following image) when you remove the bezel.
11. Remove the display bezel (6).

The display bezel is available using spare part number 767429-001 for models with a webcam and 767430-001 for models without a webcam. Display bezel mylar screw covers are available in the Rubber Kit, spare part number 767450-001.

12. If it is necessary to replace the webcam or microphone module, gently pull the module away from the double-sided tape on the display enclosure (1), and then disconnect the cable from the module (2).

The webcam module is available using spare part number 767457-001 for HD models or 807958-001 for HD, Lync models. The microphone module is available using spare part number 773563-001.
13. If it is necessary to remove the display panel from the enclosure, remove the 4 Phillips PM2.0×3.0 screws (1) that secure the panel to the display enclosure, and then lift the top of the panel upward (2).

The raw display panel is available using spare part number 767448-001 for HD panels and 768053-001 for HD+ panels (HP 440 models only).

14. Rotate the display panel all the way over (1), disconnect the display cable from the rear of the panel (2), and then remove the display panel (3) from the enclosure.

15. If it is necessary to replace the display hinges, remove the 6 Phillips PM2.0×3.0 screws (1) that secure the display hinges to the display enclosure.
16. Lift the bottom of the hinges upward (2), pull the top of the hinges out from under the tabs (3), and then remove the display hinges from the display enclosure (4).

Display hinges are available in the Display Hinge Kit using spare part number 767438-001.

17. If it is necessary to replace the display/webcam cable, lift the display/webcam cable assembly straight up and off the display panel.

The display cable is available in the Cable Kit using spare part number 767431-001.

Reverse this procedure to reassemble and install the display assembly.
### Power connector and cable

<table>
<thead>
<tr>
<th>Description</th>
<th>Spare part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power connector and cable</td>
<td>767432-001</td>
</tr>
</tbody>
</table>

Before removing the power cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the operating system.
2. Disconnect all external devices connected to the computer.
3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then unplugging the AC adapter from the computer.
4. Remove the battery (see Battery on page 36).
5. Remove the following components:
   a. Service doors (see Service door on page 37).
   b. Keyboard (see Keyboard on page 49)
   c. Hard drive (Hard drive on page 39)
   d. Optical drive (Optical drive on page 43)
   e. Top cover (see Top cover on page 53)
   f. Display assembly (see Display assembly on page 82)

Remove the power cable:

1. Disconnect the cable from the bottom of the system board (1).
2. Remove the cable from the clips built into the computer (2), and then lift the power cable from the computer (3).

Reverse this procedure to install the power cable.
Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of devices installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

**NOTE:** You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

   • To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a pointing device to click the item.

   • To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key on the keyboard.

   • To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

   • To exit Computer Setup menus without saving your changes:

     Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

     – or –
Use the arrow keys to select **Main > Ignore Changes and Exit**, and then press **enter**.

- To save your changes and exit Computer Setup menus:
  
  - Click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or -

  - Use the arrow keys to select **Main > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

### Restoring factory settings in Computer Setup

**NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press **esc** while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press **f10** to enter Computer Setup.

3. Use a pointing device or the arrow keys to select **Main > Restore Defaults**.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or -

  - Use the arrow keys to select **Main > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

**NOTE:** Your password settings and security settings are not changed when you restore the factory settings.

### Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

### Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as **ROM date** and **System BIOS**) can be revealed by pressing **fn+esc** (if you are already in Windows) or by using Computer Setup.


2. Use a pointing device or the arrow keys to select **Main > System Information**.

3. To exit Computer Setup without saving your changes, click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or -
Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.

**Downloading a BIOS update**

⚠️ **CAUTION:** To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional USB docking device, or connected to an optional power source. During the download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Access Help and Support by selecting Start > Help and Support.

2. Select Updates and tune-ups, and then select Check for HP updates now.

3. At the download area, follow these steps:
   a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.
   b. Follow the on-screen instructions to download your selection to the hard drive.

   If the update is more recent than your BIOS, make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.

   📝 **NOTE:** If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download is complete. If no instructions are revealed, follow these steps:

1. Select Start > Computer.

2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).

   The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

   📝 **NOTE:** After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.

**Using MultiBoot**

**About the boot device order**

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include...
optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices contain bootable media or files that the computer needs to start and operate properly.

**NOTE:** Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in Computer Setup. You can also press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then press `f9`. Pressing `f9` displays a menu that shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to prompt you for a boot location each time the computer turns on or restarts.

## Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

- To set a new boot order that the computer uses each time it is turned on, by changing the boot order in Computer Setup.
- To dynamically choose the boot device, by pressing `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing `f9` to enter the Boot Device Options menu.
- To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each time the computer is turned on or restarted.

### Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or restarted, follow these steps:

1. Turn on or restart the computer, and then press `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press `f10` to enter Computer Setup.
3. Use a pointing device or the arrow keys to select the **Legacy Boot Order** list, and then press `enter`.
4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the `+` key.
   - or –
   To move the device down in the boot order, use a pointing device to click the down arrow, or press the `-` key.
5. To save your changes and exit Computer Setup, click the **Save** icon in the lower-left corner of the screen, and then follow the on-screen instructions.
   - or –
   Use the arrow keys to select **Main > Save Changes and Exit**, and then press `enter`.

### Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing `esc` while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
3. Use a pointing device or the arrow keys to select a boot device, then press `enter`.

---

92 Chapter 7  Computer Setup (BIOS) and MultiBoot in Windows 7
Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select System Configuration > Boot Options, and then press enter.
4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)
5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   — or —

   Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

- To specify a boot device from the Express Boot menu, select your preference within the allotted time, and then press enter.
- To prevent the computer from defaulting to the current MultiBoot setting, press any key before the allotted time expires. The computer will not start until you select a boot device and press enter.
- To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to expire.
8 Computer Setup (BIOS) and MultiBoot in Windows 8

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of devices installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

**NOTE:** You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

- To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a pointing device to click the item.
- To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key on the keyboard.
- To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the on-screen instructions.

To exit Computer Setup menus, choose one of the following methods:

- To exit Computer Setup menus without saving your changes:
  
  Click the Exit icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or -
Use the arrow keys to select **Main > Ignore Changes and Exit**, and then press **enter**.

- To save your changes and exit Computer Setup menus:
  
  Click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
  
  - or –

Use the arrow keys to select **Main > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

### Restoring factory settings in Computer Setup

#### NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press **esc** while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press **f10** to enter Computer Setup.

3. Use a pointing device or the arrow keys to select **Main > Restore Defaults**.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or –

Use the arrow keys to select **Main > Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

#### NOTE: Your password settings and security settings are not changed when you restore the factory settings.

### Updating the BIOS

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

### Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as **ROM date** and **System BIOS**) can be revealed by pressing **fn+esc** (if you are already in Windows) or by using Computer Setup.


2. Use a pointing device or the arrow keys to select **Main > System Information**.

3. To exit Computer Setup without saving your changes, click the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  - or –
Use the arrow keys to select **Main > Ignore Changes and Exit**, and then press **enter**.

**Downloading a BIOS update**

⚠️ **CAUTION:** To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional USB docking device, or connected to an optional power source. During the download and installation, follow these instructions:

- Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
- Do not shut down the computer or initiate Sleep.
- Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. From the Start screen, type `hp support assistant`, and then select the HP Support Assistant app.
2. Click **Updates and tune-ups**, and then click **Check for HP updates now**.
3. Follow the on-screen instructions.
4. At the download area, follow these steps:
   a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.
   b. Follow the on-screen instructions to download your selection to the hard drive.

   If the update is more recent than your BIOS, make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.

**NOTE:** If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download is complete. If no instructions are revealed, follow these steps:

1. From the Start screen, type `file`, and then select **File Explorer**.
2. Click your hard drive designation. The hard drive designation is typically Local Disk (C:).
3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains the update.
4. Double-click the file that has an .exe extension (for example, `filename.exe`).

   The BIOS installation begins.
5. Complete the installation by following the on-screen instructions.

**NOTE:** After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.
Using MultiBoot

About the boot device order

As the computer starts, the system attempts to boot from enabled devices. The MultiBoot utility, which is enabled at the factory, controls the order in which the system selects a boot device. Boot devices can include optical drives, diskette drives, a network interface card (NIC), hard drives, and USB devices. Boot devices contain bootable media or files that the computer needs to start and operate properly.

NOTE: Some boot devices must be enabled in Computer Setup before they can be included in the boot order.

You can change the order in which the computer searches for a boot device by changing the boot order in Computer Setup. You can also press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then press f9. Pressing f9 displays a menu that shows the current boot devices and allows you to select a boot device. Or, you can use MultiBoot Express to set the computer to prompt you for a boot location each time the computer turns on or restarts.

Choosing MultiBoot preferences

You can use MultiBoot in the following ways:

- To set a new boot order that the computer uses each time it is turned on, by changing the boot order in Computer Setup.
- To dynamically choose the boot device, by pressing esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing f9 to enter the Boot Device Options menu.
- To use MultiBoot Express to set variable boot orders. This feature prompts you for a boot device each time the computer is turned on or restarted.

Setting a new boot order in Computer Setup

To start Computer Setup and set a boot device order that the computer uses each time it is turned on or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select one of the following options:
   - Advanced > Boot Options > UEFI Boot Order > UEFI Hybrid
   - Advanced > Boot Options > UEFI Boot Order > UEFI Native Boot mode
   - Advanced > Boot Options > Legacy Boot Order > Legacy Boot Mode
   Press enter.
4. To move the device up in the boot order, use a pointing device to click the up arrow, or press the + key.
   – or –
To move the device down in the boot order, use a pointing device to click the down arrow, or press the - key.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Dynamically choosing a boot device using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Open the Select Boot Device menu by turning on or restarting the computer, and then pressing esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.


3. Use a pointing device or the arrow keys to select a boot device, then press enter.

Setting a MultiBoot Express prompt

To start Computer Setup and set the computer to display the MultiBoot startup location menu each time the computer is started or restarted, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select Advanced > Boot Options > MultiBoot Express Boot Popup Delay (Sec), and then press enter.

4. In the MultiBoot Express Popup Delay (Sec) field, enter the length of time in seconds that you want the computer to display the startup location menu before it defaults to the current MultiBoot setting. (When 0 is selected, the Express Boot startup location menu is not displayed.)

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

   – or –

   Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Entering MultiBoot Express preferences

When the Express Boot menu is displayed during startup, you have the following choices:

● To specify a boot device from the Express Boot menu, select your preference within the allotted time, and then press enter.

● To prevent the computer from defaulting to the current MultiBoot setting, press any key before the allotted time expires. The computer will not start until you select a boot device and press enter.

● To allow the computer to start according to the current MultiBoot settings, wait for the allotted time to expire.
Computer Setup (BIOS), TPM, and HP Sure Start in Windows 10

Using Computer Setup

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of devices installed, the startup sequence of the computer, and the amount of system and extended memory.

**NOTE:** Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

**NOTE:** An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

▲ Start Computer Setup.

● Computers or tablets with keyboards:

▲ Turn on or restart the computer, and when the HP logo appears, press **f10** to enter Computer Setup.

● Tablets without keyboards:

▲ Turn off the tablet. Press the power button in combination with the volume down button until the Startup menu is displayed, and then tap **F10** to enter Computer Setup.

Navigating and selecting in Computer Setup

● To select a menu or a menu item, use the **tab** key and the keyboard arrow keys and then press **enter**, or use a pointing device to select the item.

**NOTE:** On tablets without keyboards, you can use your finger to make selections.

● To scroll up and down, select the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key on the keyboard.

● To close open dialog boxes and return to the main Computer Setup screen, press **esc**, and then follow the on-screen instructions.
To exit Computer Setup menus, choose one of the following methods:

- To exit Computer Setup menus without saving your changes:
  
  Select the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
  
  – or –
  
  Select **Main**, select **Ignore Changes and Exit**, and then press **enter**.

- To save your changes and exit Computer Setup menus:
  
  Select the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
  
  – or –
  
  Select **Main**, select **Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

### Restoring factory settings in Computer Setup

**NOTE:** Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Start Computer Setup. See [Starting Computer Setup on page 99](#).
2. Select **Main**, and then select **Apply Factory Defaults and Exit**.

**NOTE:** On select products, the selections may display **Restore Defaults** instead of **Apply Factory Defaults and Exit**.

3. Follow the on-screen instructions.

4. To save your changes and exit, select the **Save** icon in the lower-right corner of the screen, and then follow the on-screen instructions.

  – or –
  
  Select **Main**, select **Save Changes and Exit**, and then press **enter**.

Your changes go into effect when the computer restarts.

**NOTE:** Your password settings and security settings are not changed when you restore the factory settings.
**Updating the BIOS**

Updated versions of the BIOS may be available on the HP website.

Most BIOS updates on the HP website are packaged in compressed files called **SoftPaqs**.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

**Determining the BIOS version**

To decide whether you need to update Computer Setup (BIOS), first determine the BIOS version on your computer.

BIOS version information (also known as **ROM date** and **System BIOS**) can be accessed by pressing `fn+esc` (if you are already in Windows) or by using Computer Setup.

1. Start Computer Setup. See **Starting Computer Setup on page 99**.
2. Select **Main**, and then select **System Information**.
3. To exit Computer Setup without saving your changes, select the **Exit** icon in the lower-right corner of the screen, and then follow the on-screen instructions.
   – or –
   Select **Main**, select **Ignore Changes and Exit**, and then press enter.

To check for later BIOS versions, see **Downloading a BIOS update on page 101**.

**Downloading a BIOS update**

⚠️ **CAUTION:** To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

Do not disconnect power on the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Sleep.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Type `support` in the taskbar search box, and then select the HP Support Assistant app.
   – or –
   Select the question mark icon in the taskbar.
2. Select **Updates**, and then select **Check for updates and messages**.
3. Follow the on-screen instructions.
4. At the download area, follow these steps:
   a. Identify the most recent BIOS update and compare it to the BIOS version currently installed on your computer. Make a note of the date, name, or other identifier. You may need this information to locate the update later, after it has been downloaded to your hard drive.
   b. Follow the on-screen instructions to download your selection to the hard drive.
      Make a note of the path to the location on your hard drive where the BIOS update is downloaded. You will need to access this path when you are ready to install the update.
If you connect your computer to a network, consult the network administrator before installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are revealed on the screen after the download is complete. If no instructions are revealed, follow these steps:

1. Type `file` in the taskbar search box, and then select **File Explorer**.
2. Select your hard drive designation. The hard drive designation is typically Local Disk (C:).
3. Using the hard drive path you recorded earlier, open the folder that contains the update.
4. Double-click the file that has an .exe extension (for example, `filename.exe`).
   The BIOS installation begins.
5. Complete the installation by following the on-screen instructions.

After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.

### Changing the boot order using the f9 prompt

To dynamically choose a boot device for the current startup sequence, follow these steps:

1. Access the Boot Device Options menu:
   - Computers or tablets with keyboards:
     ▲ Turn on or restart the computer, and when the HP logo appears, press `f9` to enter the Boot Device Options menu.
   - Tablets without keyboards:
     ▲ Turn off the tablet. Press the power button in combination with the volume down button until the Startup menu is displayed, and then tap `F9` to enter the Boot Device Options menu.
2. Select a boot device, then press `enter`.

### TPM BIOS settings (select products only)

**IMPORTANT:** Before enabling Trusted Platform Module (TPM) functionality on this system, you must ensure that your intended use of TPM complies with relevant local laws, regulations and policies, and approvals or licenses must be obtained if applicable. For any compliance issues arising from your operation/usage of TPM which violates the above mentioned requirement, you shall bear all the liabilities wholly and solely. HP will not be responsible for any related liabilities.

TPM provides additional security for your computer. You can modify the TPM settings in Computer Setup (BIOS).

**NOTE:** If you change the TPM setting to Hidden, TPM is not visible in the operating system.

To access TPM settings in Computer Setup:

1. Start Computer Setup. See **Starting Computer Setup on page 99**.
2. Select **Security**, select **TPM Embedded Security**, and then follow the on-screen instructions.
Using HP Sure Start (select products only)

Select computer models are configured with HP Sure Start, a technology that continuously monitors the computer's BIOS for attacks or corruption. If the BIOS becomes corrupted or is attacked, HP Sure Start automatically restores the BIOS to its previously safe state, without user intervention.

HP Sure Start is configured and already enabled so that most users can use the HP Sure Start default configuration. The default configuration can be customized by advanced users.

To access the latest documentation on HP Sure Start, go to http://www.hp.com/support, and select your country. Select Drivers & Downloads, and then follow the on-screen instructions.
Computer Setup (BIOS) in Ubuntu Linux

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input and output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Computer Setup includes settings for the types of peripherals installed, the startup sequence of the computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer from operating properly.

Starting Computer Setup

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
   - To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a pointing device to click the item.
   - To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use the up arrow key or the down arrow key.
   - To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

- To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
  - or –
  Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

**NOTE**: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.
2. Press f10 to enter Computer Setup.
3. Use a pointing device or the arrow keys to select Main > Restore Defaults.
4. Follow the on-screen instructions.
5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

**NOTE**: Your password settings and security settings are not changed when you restore the factory settings.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be revealed as follows:

2. Use a pointing device or the arrow keys to select Main > System Information.
3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select Main > Ignore Changes and Exit, and then press enter.
NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing the \texttt{esc} key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen, and then pressing the \texttt{f1} key. Follow the on-screen instructions to exit this screen.

**Downloading a BIOS update**

**CAUTION:** To reduce the risk of damage to the computer or an unsuccessful installation, download and install a BIOS update only when the computer is connected to reliable external power using the AC adapter. Do not download or install a BIOS update while the computer is running on battery power, docked in an optional docking device, or connected to an optional power source. During the download and installation, follow these instructions:

- Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
- Do not shut down the computer or initiate Suspend or Hibernation.
- Do not insert, remove, connect, or disconnect any device, cable, or cord.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want to download.
3. Click the option for software and driver downloads, type your computer model number in the product box, and then press \texttt{enter}. Follow the on-screen instructions to identify your computer and access the BIOS update you want to download.
4. Click your specific product from the models listed.
5. Click the appropriate operating system.
6. Go to the BIOS section and download the BIOS software package.
7. Follow the installation instructions as provided with the downloaded BIOS software package.

**NOTE:** After a message on the screen reports a successful installation, you can delete the downloaded file from your hard drive.
11 HP PC Hardware Diagnostics (UEFI)

HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic tests to determine whether the computer hardware is functioning properly. The tool runs outside the operating system so that it can isolate hardware failures from issues that are caused by the operating system or other software components.

NOTE: To start BIOS on a convertible computer, your computer must be in notebook mode and you must use the keyboard attached to your tablet. The on-screen keyboard, which displays in tablet mode, cannot access BIOS.

To start HP PC Hardware Diagnostics UEFI:

1. Start BIOS:
   - Computers or tablets with keyboards:
     ▲ Turn on or restart the computer, quickly press esc.
   - Tablets without keyboards:
     ▲ Turn on or restart the tablet, and then quickly hold down the volume down button.
     - or -
     Turn on or restart the tablet, and then quickly hold down the Windows button.

2. Press or tap f2.
   The BIOS searches three places for the diagnostic tools, in the following order:
   a. Connected USB drive
   b. Hard drive
   c. BIOS

3. When the diagnostic tool opens, select the type of diagnostic test you want to run, and then follow the on-screen instructions. On a tablet, press the volume down button to stop a diagnostic test.

NOTE: If you need to stop a diagnostic test on computers or tablets with a keyboard, press esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

There are two options to download HP PC Hardware Diagnostics to a USB device:

Download the latest UEFI version:

2. In the HP PC Hardware Diagnostics section, click the Download link, and then select Run.
Download any version of UEFI for a specific product:

1. Go to http://www.hp.com/support, and then select your country. The HP Support page is displayed.

2. Click Drivers & Downloads.

3. In the text box, enter the product name, and then click Go.

   – or –

   Click Find Now to let HP automatically detect your product.

4. Select your computer, and then select your operating system.

5. In the Diagnostic section, follow the on-screen instructions to select and download the UEFI version you want.
Your computer includes HP and Windows tools to help you safeguard your information and retrieve it if you ever need to. These tools will help you return your computer to a proper working state, all with simple steps. This section provides information about the following processes:

● Creating recovery media and backups
● Restoring and recovering your system

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create HP Recovery media. This step creates a Windows 7 operating system DVD and a Driver Recovery DVD. The Windows DVD can be used to reinstall the original operating system in cases where the hard drive is corrupted or has been replaced. The Driver Recovery DVD installs specific drivers and applications. See Creating recovery media with HP Recovery Disc Creator on page 109.

2. Use Windows Backup and Recovery tools to perform the following:
   ● Back up individual files and folders
   ● Back up your entire hard drive (select models only)
   ● Create system repair discs (select models only) with the installed optical drive (select models only) or an optional external optical drive
   ● Create system restore points

NOTE: This guide describes an overview of backing up, restoring, and recovering options. For more details about the tools provided, see Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of system instability.

In case of system failure, you can use the backup files to restore the contents of your computer. See Backing up your information on page 110.

Guidelines

● When creating recovery media or backing up to discs, use any of the following types of discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the type of optical drive you are using.

● Be sure that the computer is connected to AC power before you start the recovery media creation process or the backup process.

Creating recovery media with HP Recovery Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery media. After you successfully set up the computer, you can create recovery media using HP Recovery Disc Creator. This recovery media allows you to reinstall your original operating system as well as select drivers and
applications if the hard drive becomes corrupted. HP Recovery Disc Creator can create two kinds of recovery DVDs:

- Windows 7 operating system DVD—Installs the operating system without additional drivers or applications.
- Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP Software Setup utility installs drivers and applications.

Creating recovery media

**NOTE:** The Windows 7 operating system DVD can be created only once. Thereafter, the option to create that media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Windows disk.
3. From the drop-down menu, select the drive for burning the recovery media.
4. Click the Create button to start the burning process.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Driver disk.
3. From the drop-down menu, select the drive for burning the recovery media.
4. Click the Create button to start the burning process.

Backing up your information

You should create system repair media and your initial backup immediately after initial system setup. As you add new software and data files, you should continue to back up your system on a regular basis to maintain a reasonably current backup. You should also create Windows system repair media (select models only) which can be used to start up (boot) the computer and repair the operating system in case of system instability or failure. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

- Store personal files in the Documents library, and back it up regularly.
- Back up templates that are stored in their associated directories.
- Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. The screen shot can be a time-saver if you have to reset your preferences.
- When backing up to discs, number each disc after removing it from the drive.

**NOTE:** For detailed instructions on various backup and restore options, perform a search for these topics in Help and Support. To access Help and Support, select Start > Help and Support.

**NOTE:** Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select Start > Help and Support.
To create a backup using Windows Backup and Restore:

**NOTE:** The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select **Start > All Programs > Maintenance > Backup and Restore.**
2. Follow the on-screen instructions to set up your backup, create a system image (select models only), or create system repair media (select models only).

**Performing a system recovery**

In case of system failure or instability, the computer provides the following tools to recover your files:

- **Windows recovery tools:** You can use Windows Backup and Restore to recover information you have previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows from starting correctly.

- **f11 recovery tools (select models only):** You can use the f11 recovery tools to recover your original hard drive image. The image includes the Windows operating system and software programs installed at the factory.

**NOTE:** If you are unable to boot (start up) your computer and you cannot use the system repair media you previously created (select models only), you must purchase Windows 7 operating system media to reboot the computer and repair the operating system. For additional information, see *Using Windows 7 operating system media* on page 112.

**Using the Windows recovery tools**

Using the Windows recovery tools, you can:

- Recover individual files
- Restore the computer to a previous system restore point
- Recover information using recovery tools

**NOTE:** For detailed instructions on various recovery and restore options, perform a search for these topics in Help and Support. To access Help and Support, select **Start > Help and Support.**

**NOTE:** Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Help and Support. To access Help and Support, select **Start > Help and Support.**

To recover information you previously backed up:

1. Select **Start > All Programs > Maintenance > Backup and Restore.**
2. Follow the on-screen instructions to recover your system settings, your computer (select models only), or your files.

To recover your information using Startup Repair, follow these steps:

**CAUTION:** Some Startup Repair options will completely erase and reformat the hard drive. All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.
1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

   To check for the Windows partition, select **Start > Computer**.

   **NOTE:** If the Windows partition is not listed, you must recover your operating system and programs using the Windows 7 operating system DVD and the **Driver Recovery** media. For additional information, see **Using Windows 7 operating system media on page 112**.

3. If the Windows partition is listed, restart the computer, and then press **f8** before the Windows operating system loads.

4. Select **Startup Repair**.

5. Follow the on-screen instructions.

   **NOTE:** For additional information on recovering information using the Windows tools, select **Start > Help and Support**.

### Using f11 recovery tools (select models only)

**CAUTION:** Using f11 completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click **Start**, right-click **Computer**, click **Manage**, and then click **Disk Management**.

   **NOTE:** If the HP Recovery partition is not listed, you must recover your operating system and programs using the Windows 7 operating system media and the **Driver Recovery** media. For additional information, see **Using Windows 7 operating system media on page 112**.

3. If the HP Recovery partition is listed, restart the computer, and then press **esc** while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press **f11** while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

### Using Windows 7 operating system media

If you cannot use the recovery media you previously created using the HP Recovery Disc Creator (select models only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the operating system.

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to [http://www.hp.com/support](http://www.hp.com/support). For worldwide support, go to [http://welcome.hp.com/country/us/en/wwcontact_us.html](http://welcome.hp.com/country/us/en/wwcontact_us.html). You can also order the DVD by calling support. For contact information, see the **Worldwide Telephone Numbers** booklet included with the computer.

**CAUTION:** Using a Windows 7 operating system DVD completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. When reformatting is complete, the recovery process helps you restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:

**NOTE:** This process takes several minutes.

1. If possible, back up all personal files.
2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before the Windows operating system loads.
3. When prompted, press any keyboard key.
4. Follow the on-screen instructions.
5. Click **Next**.
6. Select **Repair your computer**.
7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD and then insert the **Driver Recovery** DVD.
2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
To protect your information, use Windows backup and restore utilities to back up individual files and folders, back up your entire hard drive, create system repair media (select models only) by using the installed optical drive (select models only) or an optional external optical drive, or create system restore points. In case of system failure, you can use the backup files to restore the contents of your computer.

From the Start screen, type restore, click Settings, and then select from the list of displayed options.

**NOTE:** For detailed instructions on various backup and restore options, perform a search for these topics in Windows Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

**NOTE:** Windows includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. For more information, see Windows Help and Support.

### Backing up your information

Recovery after a system failure is as good as your most recent backup. You should create system repair media and your initial backup immediately after initial system setup. As you add new software and data files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

For more information on the Windows backup features, see Windows Help and Support.

### Performing a system recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

- Windows recovery tools: You can use Windows Backup and Restore to recover information you have previously backed up. You can also use Windows Automatic Repair to fix problems that might prevent Windows from starting correctly.
- f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image includes the Windows operating system and software programs installed at the factory.

**NOTE:** If you are unable to boot (start up) your computer and you cannot use the system repair media you previously created (select models only), you must purchase Windows operating system media to reboot the computer and repair the operating system. For additional information, see Using Windows operating system media (purchased separately) on page 116.

### Using the Windows recovery tools

To recover information you previously backed up, see Windows Help and Support for steps on restoring files and folders.

To recover your information using Automatic Repair, follow these steps:
CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition and the Windows partition.
   
   From the Start screen, type file, and then click File Explorer.
   
   – or –
   
   From the Start screen, type pc, and then select This PC.

NOTE: If the Windows partition and the Recovery Image partition are not listed, you must recover your operating system and programs using the Windows operating system DVD and the Driver Recovery media (both purchased separately). For additional information, see Using Windows operating system media (purchased separately) on page 116.

3. If the Windows partition and the Recovery Image partition are listed, restart the computer by pressing and holding the shift key while clicking Restart.

4. Select Troubleshoot, then select Advanced Options, and then select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search for these topics in Windows Help and Support.

Using f11 recovery tools

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the Recovery Image partition: From the Start screen, type pc, and then select This PC.

NOTE: If the Recovery Image partition is not listed, you must recover your operating system and programs using the Windows operating system media and the Driver Recovery media (both purchased separately). For additional information, see Using Windows operating system media (purchased separately) on page 116.

3. If the Recovery Image partition is listed, restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
Using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact information from the HP website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.

⚠️ **CAUTION:** Using a Windows operating system media completely erases hard drive contents and reformats the hard drive. All files that you have created and any software that you have installed on the computer are permanently removed. When reformatting is complete, the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate a full install of the operating system using a Windows operating system DVD:

⚠️ **NOTE:** This process takes several minutes.

1. If possible, back up all personal files.
2. Insert the Windows operating system DVD into the optical drive, and then restart the computer.
3. When prompted, press any keyboard key.
4. Follow the on-screen instructions.

After the installation is completed:

1. Eject the Windows operating system media and then insert the Driver Recovery media.
2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh or Windows Reset

When your computer is not working properly and you need to regain system stability, the Windows Refresh option allows you to start fresh and keep what is important to you.

The Windows Reset option allows you to perform detailed reformatting of your computer, or remove personal information before you give away or recycle your computer. For more information on these features, see Windows Help and Support.

Using HP Software Setup

HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted from the system.

1. From the Start screen, type HP Software Setup.
2. Open HP Software Setup.
3. Follow the on-screen directions to reinstall drivers or select software.
This chapter provides information about the following processes. The information in the chapter is standard procedure for most products.

- Creating recovery media and backups
- Restoring and recovering your system

For additional information, refer to the HP support assistant app.

▲ Type support in the taskbar search box, and then select the HP Support Assistant app.

- or –

Click the question mark icon in the taskbar.

**IMPORTANT:** If you will be performing recovery procedures on a tablet, the tablet battery must be at least 70% charged before you start the recovery process.

**IMPORTANT:** For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before beginning any recovery process.

### Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose the available method according to your computer model.

- Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall the original operating system in cases where the hard drive is corrupted or has been replaced. For information on creating recovery media, see Creating HP Recovery media (select products only) on page 117. For information on the recovery options that are available using the recovery media, see Using Windows tools on page 118.

- Use Windows tools to create system restore points and create backups of personal information.

  For more information, see Recovering using HP Recovery Manager on page 119.

**NOTE:** If storage is 32 GB or less, Microsoft System Restore is disabled by default.

### Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the **Start** menu, select **File Explorer**, and then select **This PC**.

- If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery media for your system from support. See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact information on the HP website. Go to [http://www.hp.com/support](http://www.hp.com/support), select your country or region, and follow the on-screen instructions.
You can use Windows tools to create system restore points and create backups of personal information, see Using Windows tools on page 118.

- If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery Manager to create recovery media after you successfully set up the computer. HP Recovery media can be used to perform system recovery if the hard drive becomes corrupted. System recovery reinstallation the original operating system and software programs that were installed at the factory and then configures the settings for the programs. HP Recovery media can also be used to customize the system or restore the factory image if you replace the hard drive.

  - Only one set of recovery media can be created. Handle these recovery tools carefully, and keep them in a safe place.
  - HP Recovery Manager examines the computer and determines the required storage capacity for the media that will be required.
  - To create recovery discs, your computer must have an optical drive with DVD writer capability, and you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use rewritable discs such as CD±RW, DVD±RW, double-layer DVD±RW, or BD-RE (rewritable Blu-ray) discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-quality blank USB flash drive.
  - If your computer does not include an integrated optical drive with DVD writer capability, but you would like to create DVD recovery media, you can use an external optical drive (purchased separately) to create recovery discs. If you use an external optical drive, it must be connected directly to a USB port on the computer; the drive cannot be connected to a USB port on an external device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs for your computer from HP. See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact information on the HP website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
  - Be sure that the computer is connected to AC power before you begin creating the recovery media.
  - The creation process can take an hour or more. Do not interrupt the creation process.
  - If necessary, you can exit the program before you have finished creating all of the recovery DVDs. HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery Manager, you will be prompted to continue.

To create HP Recovery media:

**IMPORTANT:** For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before beginning these steps.

1. Type recovery in the taskbar search box, and then select HP Recovery Manager.
2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 119.

**Using Windows tools**

You can create recovery media, system restore points, and backups of personal information using Windows tools.

**NOTE:** If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see the Get started app.

* ▲ Select the Start button, and then select the Get started app.
Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation and level of expertise:

**IMPORTANT:** Not all methods are available on all products.

- Windows offers several options for restoring from backup, refreshing the computer, and resetting the computer to its original state. For more information see the Get started app.
  
  ▲ Select the Start button, and then select the Get started app.

- If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/or applications option (select products only) of HP Recovery Manager to reinstall the individual application or driver.
  
  ▲ Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers and/or applications, and then follow the on-screen instructions.

- If you want to recover the Windows partition to original factory content, you can choose the System Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media. For more information, see Recovering using HP Recovery Manager on page 119. If you have not already created recovery media, see Creating HP Recovery media (select products only) on page 117.

- On select products, if you want to recover the computer's original factory partition and content, or if you have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more information, see Recovering using HP Recovery Manager on page 119.

- On select products, if you want to remove the recovery partition to reclaim hard drive space, HP Recovery Manager offers the Remove Recovery Partition option. For more information, see Removing the HP Recovery partition (select products only) on page 122.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery partition (select products only). If you have not already created recovery media, see Creating HP Recovery media (select products only) on page 117.

What you need to know before you get started

- HP Recovery Manager recovers only software that was installed at the factory. For software not provided with this computer, you must either download the software from the manufacturer's website or reinstall the software from the media provided by the manufacturer.

  **IMPORTANT:** Recovery through HP Recovery Manager should be used as a final attempt to correct computer issues.

- HP Recovery media must be used if the computer hard drive fails. If you have not already created recovery media, see Creating HP Recovery media (select products only) on page 117.

- To use the Factory Reset option (select products only), you must use HP Recovery media. If you have not already created recovery media, see Creating HP Recovery media (select products only) on page 117.

- If your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not work, you can obtain recovery media for your system from support. See the Worldwide Telephone Numbers booklet included with the computer. You can also find contact information from the HP
IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

NOTE: Only the options available for your computer display when you start the recovery process.

- System Recovery—Reinstalls the original operating system, and then configures the settings for the programs that were installed at the factory.
- Factory Reset—Restores the computer to its original factory state by deleting all information from the hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

IMPORTANT: For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before beginning these steps (select products only).

1. Type recovery in the taskbar search box, select Recovery Manager, and then select HP Recovery Environment.
   - or-
   For computers or tablets with keyboards attached, press f11 while the computer boots, or press and hold f11 as you press the power button.
   For tablets without keyboards:
   Turn on or restart the tablet, and then quickly hold down the volume down button; then select f11.
   - or -
   Turn on or restart the tablet, and then quickly hold down the Windows button; then select f11.
2. Select Troubleshoot from the boot options menu.
3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.
2. Insert the HP Recovery media, and then restart the computer.
   
   NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer boot order. See Changing the computer boot order on page 121.
3. Follow the on-screen instructions.
Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is the order of devices listed in BIOS where the computer looks for startup information. You can change the selection to an optical drive or a USB flash drive.

To change the boot order:

**IMPORTANT:** For a tablet with a detachable keyboard, connect the keyboard to the keyboard dock before beginning these steps.

1. Insert the HP Recovery media.
2. Access BIOS:
   
   For computers or tablets with keyboards attached:
   
   ▲ Turn on or restart the computer or tablet, quickly press `esc`, and then press `f9` for boot options.
   
   For tablets without keyboards:
   
   ▲ Turn on or restart the tablet, and then quickly hold down the volume down button; then select `f9`.
   
   - or -
   
   Turn on or restart the tablet, and then quickly hold down the Windows button; then select `f9`.

3. Select the optical drive or USB flash drive from which you want to boot.
4. Follow the on-screen instructions.
Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

**IMPORTANT:** After you remove the HP Recovery partition, you will not be able to perform System Recovery or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition, create HP Recovery media; see Creating HP Recovery media (select products only) on page 117.

**NOTE:** The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:

1. Type `recovery` in the taskbar search box, and then select **HP Recovery Manager**.
2. Select **Remove Recovery Partition**, and then follow the on-screen instructions.
15 Backup and Recovery in Ubuntu Linux

Recovery after a system failure is as good as your most recent backup. As you add new software and data files, you should continue to back up your system on a regular basis to maintain a reasonably current backup.

Your computer includes tools provided by HP to help you safeguard your information and retrieve it if ever needed.

Creating backups

1. Create restore media immediately after you set up the computer. For more information, see Performing a system recovery on page 124.
2. As you add files, routinely create a backup of your system and personal information.

Backing up your information

You should back up your computer files on a regular schedule to maintain a current backup. You can manually back up your information to an optional external drive, a network drive, or discs. Back up your system at the following times:

- At regularly scheduled times
- Before the computer is repaired or restored
- Before you add or modify hardware or software

To back up your home directory files using Backup Manager Settings:

1. Select Computer > More Applications > Tools > Backup Manager Settings, and click Backup my home directory.
2. Click Storage Destination Location, and then select a location to back up your information.
3. Click Schedule, and then select a time schedule to perform backups at a regularly scheduled time.
   
   To immediately back up your information, click the Backup Now check box.

   ✋ NOTE: Before you back up your information, be sure you have designated a location to save the backup files.

4. Click Save and Backup to start the backup and to save the backup settings.

To restore backup files:

2. Click Backup Source, and then select the location of the backup files.
3. Click Restore Destination, and then select the destination to restore the files.
4. To restore all files from the selected location, click Restore all files. To restore select files only, click Restore selected files, click Select Files and then select the files to be restored.
5. Under Restore Point, click the time and date of the backup.
NOTE: If multiple backups have been performed, click **Use the latest version** to restore the latest version.

6. Click **Restore** to start restoring the files, or click **Cancel** to cancel the operation.

**Performing a system recovery**

Recovery allows you to repair or restore the computer to its original factory state. You can create an HP Factory Image, using an installed or an external DVD±RW optical drive.

**NOTE:** Your computer may not come equipped with an internal optical drive. In order to create the HP Factory Image, you may need to plug in an external optical drive.

**CAUTION:** Using Recovery completely erases hard drive contents and reformats the hard drive. All files you have created and any software installed on the computer are permanently removed. The recovery tool reinstalls the original operating system and HP programs and drivers that were installed at the factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files must be restored from a backup.

To restore the computer using the HP Factory Image, you must first create the recovery ISO file and then burn it to an optical disc.

**NOTE:** HP recommends that you create the HP Factory Image in the event of a system failure.

1. Select **Computer > More Applications**.
2. In the left pane, click **Tools**, and then click **Create HP Factory Image** in the right pane.
3. Enter the root password when prompted.
4. Right-click on the HP_Recovery.iso file and select **Open with Brasero**.
5. Insert a blank DVD disc and select **Burn**. This creates the HP Factory Image Restore DVD.

To restore the computer from the recovery disc, follow these steps:

1. If possible, back up all personal files.
2. Insert the HP Factory Image Restore DVD into the optical drive and restart the computer.
3. As the computer is restarting, press **f9** to open the Computer Setup boot option menu.
4. Select **Optical Disk Drive** from the Boot Options menu and press **enter**.
5. Press **enter** to select **Restore System from Media**.
6. At both of the System Recovery prompts, select **Yes**.

**USB Recovery option (select models only)**

The USB Recovery Disk On Key (flash drive) option allows you to create a backup image of the Ubuntu operating system installed on select HP Business Notebooks. This Disk On Key may be used to restore the system to the original factory state when the F11 recovery option is not available. This process should be done on first obtaining the computer.

**CAUTION:** The USB recovery option does not preserve data present on the computer’s hard drive or on the Disk On Key used for the recovery process. Back up any data on the Disk on Key or the notebook that will be recovered before starting.
NOTE: HP recommends that you create the USB Recovery Disk in the event of a system failure. The Disk On Key used for this process should be 4 GB or larger.

Creating a USB Recovery Disk On Key
1. Connect the USB Disk On Key to a USB port on the computer.
2. Select Computer > More applications > Tools > Create Recovery USB.
3. Enter the root password when prompted.
4. Select USB Disk On Key from the list.
5. Click OK.
6. A question dialog will remind you that the data on the USB key will be destroyed. To continue, click OK. Otherwise, click Cancel and back up the contents of the Disk On Key on another computer.
7. The backup process will display a status dialog box while the backup is in progress.

NOTE: A file browser window with the Disk On Key Contents displayed will pop up when the key is mounted. You may close the file browser window if desired. Once the USB Recovery Key has been created, the status dialog will close. The USB Recovery Key is ready for use.

Recovering from a USB Recovery Disk On Key

CAUTION: Before starting the Recovery process, make sure any data on the system to be recovered has been backed up. The recovery process destroys all data on the system to be recovered.
1. Turn off the computer.
2. Connect the USB Disk On Key to a USB port on the computer.
3. Turn on the computer while holding down the f9 key.
4. Once the system has booted, the Boot Options menu should appear.
5. Using the arrow keys, select USB Disk On Key and press enter.

NOTE: The description may vary from one USB key to another. Any entry other than Optical Disk Drive, Notebook Hard Drive or Notebook Ethernet should be the USB Recovery Disk On Key.
6. Once the USB Recovery Disk On Key has been selected, press enter. The USB Recovery Disk On Key will boot.
7. Once the USB Recovery Disk On Key has booted, a dialog box will prompt, “Do you want to start the System–Restore?” If data on the computer has not been backed up, use the tab key and select No. The system will reboot. Back up the system data and repeat the previous steps. If no data should be saved from the computer, use the tab key to select Yes. Press enter to begin the recovery process.
8. After the files are copied to the system, follow the on-screen instructions.

Remove everything and reinstall Ubuntu

Sometimes you want to perform detailed reformatting of your computer, or you want to remove personal information before you give away or recycle your computer. The process described in this section provides a speedy, simple way to return the computer to its original state. This option removes all personal data, applications, and settings from your computer, and reinstalls the Linux operating system.

IMPORTANT: This option does not provide backups of your information. Before using this option, back up any personal information you wish to retain.
You can initiate this option by using the f11 key.

To use the f11 key:

Press f11 while the computer boots.

– or –

Press and hold f11 as you press the power button.

The following options are available:

● Cancel/Reboot—Reboots the system. No recovery or restore activity is performed.

● Recover/Repair System—This option repairs a system that is not working properly and preserves user data.

● Restore Factory System—This option restores the system back to the original factory state. User data is not preserved.

Select an option and follow the on-screen instructions.
# 16 Specifications

## Computer specifications

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-touch</td>
<td>244.0 cm</td>
<td>9.61 in</td>
</tr>
<tr>
<td>Touch</td>
<td>244.5 mm</td>
<td>9.62 in</td>
</tr>
<tr>
<td>Width</td>
<td>339.2 mm</td>
<td>13.35 in</td>
</tr>
<tr>
<td>Height (front to rear)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-touch</td>
<td>23.1 to 25.2 mm</td>
<td>0.91 to 0.99 in</td>
</tr>
<tr>
<td>Touch</td>
<td>24.5 to 26.6 mm</td>
<td>0.96 to 1.05 in</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Non-touchscreen (equipped with 1 DIMM, M.2 SSD, WLAN module, webcam, 4 cell battery, optical drive)</td>
<td>1.94 kg</td>
<td>4.29 lbs</td>
</tr>
<tr>
<td>Non-touchscreen (equipped with 1 DIMM, M.2 SSD, WLAN module, webcam, 4 cell battery, no optical drive)</td>
<td>1.83 kg</td>
<td>4.04 lbs</td>
</tr>
<tr>
<td>Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN module, webcam, 4 cell battery, optical drive)</td>
<td>2.03 kg</td>
<td>4.49 lbs</td>
</tr>
<tr>
<td>Non-touchscreen (equipped with 1 DIMM, hard drive, WLAN module, webcam, 4 cell battery, no optical drive)</td>
<td>1.92 kg</td>
<td>4.24 lbs</td>
</tr>
<tr>
<td>Touchscreen (equipped with 1 DIMM, hard drive, WLAN module, webcam, 4 cell battery), optical drive</td>
<td>2.43 kg</td>
<td>5.35 lbs</td>
</tr>
<tr>
<td>Touchscreen (equipped with 1 DIMM, hard drive, WLAN module, webcam, 4 cell battery), no optical drive</td>
<td>2.32 kg</td>
<td>5.10 lbs</td>
</tr>
<tr>
<td><strong>Input power</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating voltage</td>
<td>19.0 V dc @ 4.74 A – 90 W or 18.5 V dc @ 3.5 A - 65 W</td>
<td></td>
</tr>
<tr>
<td>Operating current</td>
<td>4.74 A or 3.5 A</td>
<td></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating (not writing to optical disc)</td>
<td>0°C to 35°C</td>
<td>32°F to 95°F</td>
</tr>
<tr>
<td>Operating (writing to optical disc)</td>
<td>5°C to 35°C</td>
<td>41°F to 95°F</td>
</tr>
<tr>
<td>Nonoperating</td>
<td>-20°C to 60°C</td>
<td>-4°F to 140°F</td>
</tr>
<tr>
<td><strong>Relative humidity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>10% to 90%</td>
<td></td>
</tr>
<tr>
<td>Nonoperating</td>
<td>5% to 95%</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum altitude</strong> (unpressurized)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Shock

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>125 g, 2 ms, half-sine</td>
<td></td>
</tr>
<tr>
<td>Nonoperating</td>
<td>200 g, 2 ms, half-sine</td>
<td></td>
</tr>
</tbody>
</table>

### Random vibration

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating</td>
<td>0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate</td>
<td></td>
</tr>
<tr>
<td>Nonoperating</td>
<td>1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this range of temperatures.

## 35.6-cm (14.0-in) display specifications

<table>
<thead>
<tr>
<th></th>
<th>Metric</th>
<th>U.S.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active diagonal size</td>
<td>35.6-cm</td>
<td>14.0-in</td>
</tr>
<tr>
<td>Resolution</td>
<td>HD: 1366x768</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HD+: 1600x900</td>
<td></td>
</tr>
<tr>
<td>Surface treatment</td>
<td>Anti-glare</td>
<td></td>
</tr>
<tr>
<td>Panel Width</td>
<td>HD: 3.8 mm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HD+: 3.6 mm</td>
<td></td>
</tr>
<tr>
<td>Brightness</td>
<td>HD: 200 nits (typical)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HD+: 300 nits (typical)</td>
<td></td>
</tr>
<tr>
<td>Viewing angle</td>
<td>SVA</td>
<td></td>
</tr>
<tr>
<td>Backlight</td>
<td>WLED</td>
<td></td>
</tr>
<tr>
<td>Viewing angle</td>
<td>45/45/15/35</td>
<td></td>
</tr>
<tr>
<td>Frequency</td>
<td>60 Hz</td>
<td></td>
</tr>
<tr>
<td>Display colors</td>
<td>262K</td>
<td></td>
</tr>
<tr>
<td>Response time</td>
<td>2ms /6 ms(Typ)(Tr/Td)</td>
<td></td>
</tr>
</tbody>
</table>
# Hard drive specifications

<table>
<thead>
<tr>
<th></th>
<th>1.5-TB*</th>
<th>1-TB*</th>
<th>750-GB*</th>
<th>500-GB*</th>
<th>500-GB* hybrid</th>
<th>320-GB*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>9.5 mm</td>
<td>9.5 mm</td>
<td>9.5 mm</td>
<td>9.5 mm or 7.0 mm</td>
<td>7.0 mm</td>
<td>7.0 mm</td>
</tr>
<tr>
<td>Width</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
<td>70 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>118 g</td>
<td>115 g</td>
<td>102 g</td>
<td>101 g or 95 g</td>
<td>95 g</td>
<td>95 g</td>
</tr>
<tr>
<td><strong>Interface type</strong></td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
<td>SATA</td>
</tr>
<tr>
<td><strong>Transfer rate</strong></td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
<td>100 MB/sec</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
<td>ATA security</td>
</tr>
<tr>
<td><strong>Seek times</strong> (typical read, including setting)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single track</td>
<td>2.2 ms</td>
<td>1.4 ms</td>
<td>1.1 ms</td>
<td>3 ms</td>
<td>2 ms</td>
<td>1.1 ms</td>
</tr>
<tr>
<td>Average</td>
<td>13 ms</td>
<td>10 ms</td>
<td>12 ms</td>
<td>13 ms</td>
<td>12 ms</td>
<td>13 ms</td>
</tr>
<tr>
<td>Maximum</td>
<td>25 ms</td>
<td>12 ms</td>
<td>21 ms</td>
<td>24 ms</td>
<td>22 ms</td>
<td>25 ms</td>
</tr>
<tr>
<td><strong>Logical blocks</strong></td>
<td>2,930,277,168</td>
<td>1,938,921,461</td>
<td>1,465,149,168</td>
<td>1,048,576,000</td>
<td>976,773,168</td>
<td>625,141,400</td>
</tr>
<tr>
<td><strong>Disc rotational speed</strong></td>
<td>5400 rpm</td>
<td>5400 rpm</td>
<td>7200 rpm or 5400 rpm</td>
<td>7200 rpm or 5400 rpm</td>
<td>5400 rpm</td>
<td>5400 rpm</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>0°C to 60°C (32°F to 140°F)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may differ slightly.

**NOTE:** Certain restrictions and exclusions apply. Contact technical support for details.
# Solid-state drive specifications

<table>
<thead>
<tr>
<th></th>
<th>120-GB*</th>
<th>128-GB*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Height</strong></td>
<td>1.35 mm</td>
<td>7.0 mm</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>&lt; 10 g</td>
<td>&lt; 50 g</td>
</tr>
<tr>
<td><strong>Form factor</strong></td>
<td>M.2 2242-D2-B-M</td>
<td>2.5-inch</td>
</tr>
<tr>
<td><strong>Transfer rate</strong></td>
<td>up to 540 MB/sec</td>
<td>up to 515 MB/sec</td>
</tr>
<tr>
<td><strong>Interface type</strong></td>
<td>SATA-3</td>
<td>SATA-3</td>
</tr>
<tr>
<td><strong>Ready time, maximum (to not busy)</strong></td>
<td>1.0 ms</td>
<td>&lt; 1.0 ms</td>
</tr>
<tr>
<td><strong>Access times, logical</strong></td>
<td>0.1 ms</td>
<td>0.1 ms</td>
</tr>
<tr>
<td><strong>Total logical sectors</strong></td>
<td>234,441,648</td>
<td>250,069,680</td>
</tr>
<tr>
<td><strong>Operating temperature</strong></td>
<td>0°C to 70°C (32°F to 158°F)</td>
<td></td>
</tr>
</tbody>
</table>

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications may differ slightly.

**NOTE:** Certain restrictions and exclusions apply. Contact technical support for details.
## DVD±RW SuperMulti DL Drive specifications

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Center hole diameter</th>
<th>1.5 cm (0.59 in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disc diameter</td>
<td></td>
</tr>
<tr>
<td>Standard disc</td>
<td>12 cm (4.72 in)</td>
</tr>
<tr>
<td>Mini disc</td>
<td>8 cm (3.15 in)</td>
</tr>
<tr>
<td>Disc thickness</td>
<td>1.2 mm (0.047 in)</td>
</tr>
<tr>
<td>Track pitch</td>
<td>0.74 µm</td>
</tr>
<tr>
<td>Access time</td>
<td></td>
</tr>
<tr>
<td>CD</td>
<td>DVD</td>
</tr>
<tr>
<td>Random</td>
<td>&lt; 175 ms</td>
</tr>
<tr>
<td>Full stroke</td>
<td>&lt; 285 ms</td>
</tr>
<tr>
<td>Audio output level</td>
<td>Line-out, 0.7 Vrms</td>
</tr>
<tr>
<td>Cache buffer</td>
<td>2 MB</td>
</tr>
<tr>
<td>Data transfer rate</td>
<td></td>
</tr>
<tr>
<td>24X CD-ROM</td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td>8X DVD-ROM</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>24X CD-R</td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td>16X CD-RW</td>
<td>2,400 KB/sec</td>
</tr>
<tr>
<td>8X DVD+R</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>4X DVD+RW</td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td>8X DVD-R</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>4X DVD-RW</td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td>2.4X DVD+R(9)</td>
<td>2,700 KB/sec</td>
</tr>
<tr>
<td>5X DVD-RAM</td>
<td>6,750 KB/sec</td>
</tr>
<tr>
<td>Transfer mode</td>
<td>Multiword DMA Mode</td>
</tr>
<tr>
<td>Startup time</td>
<td>&lt; 15 seconds</td>
</tr>
<tr>
<td>Stop time</td>
<td>&lt; 6 seconds</td>
</tr>
</tbody>
</table>
**Blu-ray ROM DVD±RW SuperMulti DL Drive**

<table>
<thead>
<tr>
<th>Applicable disc</th>
<th>Read:</th>
<th>Write:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Access time</th>
<th>CD</th>
<th>DVD</th>
<th>HD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random</td>
<td>170 ms</td>
<td>170 ms</td>
<td>230 ms</td>
</tr>
</tbody>
</table>

| Cache buffer | 8 MB |

<table>
<thead>
<tr>
<th>Data transfer rate</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>24X CD-ROM</td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td>8X DVD</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>24X CD-R</td>
<td>3,600 KB/sec</td>
</tr>
<tr>
<td>16X CD-RW</td>
<td>2,400 KB/sec</td>
</tr>
<tr>
<td>8X DVD+R</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>4X DVD+RW</td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td>8X DVD-R</td>
<td>10,800 KB/sec</td>
</tr>
<tr>
<td>4X DVD-RW</td>
<td>5,400 KB/sec</td>
</tr>
<tr>
<td>2.4X DVD+R(9)</td>
<td>2,700 KB/sec</td>
</tr>
<tr>
<td>5X DVD-RAM</td>
<td>6,750 KB/sec</td>
</tr>
<tr>
<td>1X BD-ROM</td>
<td>4,500 KB/sec</td>
</tr>
<tr>
<td>1X BD-R read</td>
<td>4,500 KB/sec</td>
</tr>
<tr>
<td>1X BD-RE read</td>
<td>4,500 KB/sec</td>
</tr>
</tbody>
</table>

| Transfer mode       | Multiword DMA Mode |

**DVD-ROM drive**

| Applicable disc | DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form 2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge |

| Center hole diameter | 1.5 cm (0.59 in) |

<table>
<thead>
<tr>
<th>Disc diameter</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard disc</td>
<td>12 cm (4.72 in)</td>
</tr>
<tr>
<td>Mini disc</td>
<td>8 cm (3.15 in)</td>
</tr>
</tbody>
</table>
Specification information in Device Manager

Device Manager allows you to view and control the hardware attached to the computer, as well as provides hardware specification information.

You can also add hardware or modify device configurations using Device Manager.

**NOTE:**
Windows 7 includes the User Account Control feature to improve the security of your computer. You may be prompted for your permission or password for tasks such as installing software, running utilities, or changing Windows settings. Refer to Windows Help and Support for more information.

After you open Device Manager, drill-down to a device and double-click it to access its properties.

**To access Device Manager in Windows 8:**

1. From the Start screen, type `control`, and then select **Control Panel**.

2. Select **System and Security**, and then in the System area, click **Device Manager**.

   A list display all the devices installed in your computer.

**To access Device Manager in Windows 7:**

1. Select **Start > Computer > System properties**.

2. In the left pane, click **Device Manager**.

---

| Disc thickness | 1.2 mm (0.047 in) |
| Track pitch | 0.74 μm |
| **Access time** | **CD** | **DVD** |
| Random | < 100 ms | < 125 ms |
| Full Stroke | < 175 ms | < 225 ms |
| **Audio output level** | Line-out, 0.7 Vrms |
| **Cache buffer** | 512 KB |
| **Data transfer rate** |  |
| CD-R (24X) | 3600 KB/s (150 KB/s at 1X CD rate) |
| CD-RW (10X) | 1500 KB/s (150 KB/s at 1X CD rate) |
| CD-ROM (24X) | 3,600 KB/sec |
| DVD (8X) | 3600 KB/s (150 KB/s at 1X CD rate) |
| Multiword DMA mode 2 | 16.6 MB/s |
| **Startup time** | < 10 seconds |
| **Stop time** | < 3 seconds |
17 Statement of Volatility

The purpose of this document is to provide general information regarding non-volatile memory in industry-standards based HP Business Notebook PC systems and provide general instructions for restoring nonvolatile memory that can contain personal data after the system has been powered off and the hard drive has been removed.

HP Business Notebook PC products that use Intel®-based or AMD®-based system boards contain volatile DDR memory. The amount of nonvolatile memory present in the system depends upon the system configuration. Intel-based and AMD-based system boards contain nonvolatile memory subcomponents as originally shipped from HP assuming that no subsequent modifications have been made to the system and assuming that no applications, features, or functionality have been added to or installed on the system.

Following system shutdown and removal of all power sources from an HP Business Notebook PC system, personal data can remain on volatile system memory (DIMMs) for a finite period of time and will also remain in nonvolatile memory. The steps below will remove personal data from the notebook PC, including the nonvolatile memory found in Intel-based and AMD-based system boards. Some of these steps are disclosed in the Maintenance & Service Guides available for HP PC products available on the product support pages at www.hp.com.

1. Follow steps (a) through (l) below to restore the nonvolatile memory that can contain personal data. Restoring or reprogramming nonvolatile memory that does not store personal data is neither necessary nor recommended.
   a. Enter BIOS (F10) Setup by powering on the system and pressing F10 when prompted near the bottom of the display, or press the ESC key to display the start up menu, then press F10. If the system has a BIOS administrator password, enter the password at the prompt.
   b. Select the **File** menu, then **Restore Defaults**.
   c. Select the **System Configuration** menu, then **Restore Security Defaults**.
   d. If an asset or ownership tag is set, select the **Security** menu and scroll down to the **Utilities** menu. Select **System IDs**, and then select the tag that has been set. Press the spacebar once to clear the tag, then press Enter to return to the prior menu.
   e. If a DriveLock password is set, select the **Security** menu, scroll down to **DriveLock**, then select **DriveLock password**. Select the desired hard drive. Click **Disable protection**, enter the existing master DriveLock password, then press Enter to confirm and return to the prior menu. Repeat this procedure if more than one hard drive has a DriveLock password.
   f. If an Automatic DriveLock password is set, select the **Security** menu, scroll down to **Automatic DriveLock**, then select the desired hard drive and disable protection. Repeat this procedure if more than one hard drive has an Automatic DriveLock password.
   g. Select the **File** menu, then **Reset BIOS Security to factory default**. Click yes at the warning message.
   h. Select the **File** menu, then **Save Changes and Exit**.
   i. Reboot the system. If the system has a Trusted Platform Module (TPM) and/or fingerprint sensor, one or two prompts will appear. One to clear the TPM and the other to Reset Fingerprint Sensor; press F1 to accept or F2 to reject.

If the HP notebook model number ends in a ‘p’ or ‘w’ and includes Intel® Centrino with VProTM, reboot the PC and enter BIOS Setup by pressing F10 when prompted. Select **System Configuration**,...
then **AMT Options**. Then select **Unconfigure AMT** on next boot. Select **Save** then **Yes**. Select the **File** menu, and then select **Save Changes and Exit**. Reboot the system and confirm that you want to unconfigure AMT.

**j.** If the optional Intel® Anti-Theft Technology (AT) was activated, contact the provider to deactivate it.

**k.** If the optional Absolute® Software Computrace® management and tracking service was activated on the notebook PC, contact the provider to deactivate it.

**l.** Remove all power and system batteries for at least 24 hours.

2. Remove and retain the storage drive or clear the contents of the drive.

   **a.** **Hard Disk Drive (HDD)**

   Clear the HDD contents by using the HP Disk Sanitizer® utility or a third party application that, ideally, is U.S. Department of Defense (DOD) 5220.22-M approved.

   To run HP Disk Sanitizer, enter BIOS Setup by powering on the system and pressing F10 when prompted near the bottom of the display, or press ESC to display the start up menu, then press F10. Select the **Security** menu and scroll down to the **Utilities** menu. Select **Disk Sanitizer** and select the desired drive. For a higher level of protection, select **Optimum**.

   **NOTE:** This process will take a long time, and the amount of time varies based on the hard drive capacity.

   **b.** **Solid State Drive (SSD)**

   Clear the SSD contents by using the BIOS Setup Secure Erase command option, or by using a third party utility designed to erase data from an SSD. To run Secure Erase, enter BIOS Setup by powering on the system and pressing F10 when prompted near the bottom of the display. Select the **Security** menu and scroll down to the **Utilities** menu. Select **Secure Erase** and select the desired hard drive.
## Non-volatile memory usage

<table>
<thead>
<tr>
<th>Non Volatile Memory Type</th>
<th>Amount (Size)</th>
<th>Does this memory store customer data?</th>
<th>Does this memory retain data when power is removed?</th>
<th>What is the purpose of this memory?</th>
<th>How is data input into this memory?</th>
<th>How is this memory write protected?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Time Clock (RTC) battery backed-up CMOS configuration memory (CMOS)</td>
<td>256 Bytes</td>
<td>No</td>
<td>Yes</td>
<td>Stores system date and time and limited keyboard controller data.</td>
<td>Using the F10 Setup utility or changing the Microsoft® Windows® date &amp; time.</td>
<td>This memory is not write-protected. HP recommends password protecting the F10 Setup utility.</td>
</tr>
<tr>
<td>Controller (NIC) EEPROM</td>
<td>64 Kbytes (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Store NIC configuration and NIC firmware.</td>
<td>Using a utility from the NIC vendor that can be run from DOS.</td>
<td>A utility is required to write data to this memory and is available from NIC vendor. Writing data to this ROM in an inappropriate manner will render the NIC nonfunctional.</td>
</tr>
<tr>
<td>Keyboard ROM</td>
<td>64 Kbytes (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Stores firmware code (keyboard, mouse, &amp; battery management).</td>
<td>Programmed at the factory. Code is updated when the system BIOS is updated.</td>
<td>A utility is required for writing data to this memory and is available on the HP website. Writing data to this ROM in an inappropriate manner can render the PC nonfunctional.</td>
</tr>
<tr>
<td>DIMM Serial Presence Detect (SPD) configuration data</td>
<td>256 Bytes per memory module, 128 Bytes programmable (not customer accessible)</td>
<td>No</td>
<td>Yes</td>
<td>Stores memory module information.</td>
<td>Programmed by the memory vendor.</td>
<td>Data cannot be written to this memory when the module is installed in a PC. The specific write protection method varies by memory vendor.</td>
</tr>
<tr>
<td>System BIOS</td>
<td>4 to 5 MBytes</td>
<td>Yes</td>
<td>Yes</td>
<td>Store system BIOS code and PC configuration data.</td>
<td>System BIOS code is programmed at the factory. Code is updated when the system BIOS is updated. Configuration data and settings are input using the F10 setup utility or a custom utility.</td>
<td>A utility is required for writing data to this memory and is available on the HP website. Writing data to this ROM in an inappropriate manner can render the PC nonfunctional.</td>
</tr>
</tbody>
</table>
| Intel Management Engine Firmware (present only in models ending in a ‘p’ or ‘w’ or with Intel Centrino Pro technology) | 1.5 or 5MByte | Yes | Yes | Stores Management Engine Code, Settings, Provisioning Data and iAMT third party data store. | Management Engine Code is programmed at the factory. Code is updated via Intel secure firmware update utility. Unique Provisioning Data can be entered at the factory or by an administrator using the Management Engine (MEBx) setup utility. The third party data store | The Intel chipset is configured to enforce HW protection to block all direct read/write access to this area. An Intel utility is required for updating the firmware. Only firmware updates digitally signed by

---

136 Chapter 17 Statement of Volatility
contents can populated by a remote management console or local applications registered by an administrator to have access to the space. Intel can be applied using this utility.

<table>
<thead>
<tr>
<th>Bluetooth flash</th>
<th>2Mbit</th>
<th>No</th>
<th>Yes</th>
<th>Stores Bluetooth configuration and firmware.</th>
<th>Programmed at the factory. Tools for writing data to this memory are not publicly available but can be obtained from the silicon vendor.</th>
<th>A utility is required for writing data to this memory and is made available through newer versions of the driver if the flash requires an upgrade.</th>
</tr>
</thead>
<tbody>
<tr>
<td>802.11 WLAN EEPROM</td>
<td>4kb to 8kb</td>
<td>No</td>
<td>Yes</td>
<td>Stores configuration and calibration data.</td>
<td>Programmed at the factory. Tools for writing data to this memory are not made public.</td>
<td>A utility is required for writing data to this memory and is typically not made available to the public unless a firmware upgrade is necessary to address a unique issue.</td>
</tr>
<tr>
<td>Web camera</td>
<td>64K bit</td>
<td>No</td>
<td>Yes</td>
<td>Store Web Cam configuration and firmware.</td>
<td>Using a utility from the device manufacturer that can be run from Windows.</td>
<td>A utility is required for writing data to this memory and is typically not made available to the public unless a firmware upgrade is necessary to address a unique issue.</td>
</tr>
<tr>
<td>Fingerprint reader</td>
<td>512kByte Flash</td>
<td>Yes</td>
<td>Yes</td>
<td>Stores fingerprint templates.</td>
<td>By enrolling in HP ProtectTools Security Manager.</td>
<td>Only a digitally signed application can make the call to write to the flash.</td>
</tr>
</tbody>
</table>
Questions and answers

1. **How can the BIOS settings be restored (returned to factory settings)?**
   
a. Turn on or restart the computer and press F10 when prompted near the bottom of the display.

b. Select File, then select **Restore defaults**.

c. Follow the on-screen instructions.

d. Select File, save changes and exit, then press Enter.

2. **What kind of configuration data is stored on the DIMM Serial Presence Detect (SPD) memory module? How would this data be written?**

   The DIMM SPD memory contains information about the memory module such as size, serial number, data width, speed/timing, voltage and thermal information. This information is written by the module manufacturer and stored on an EEPROM. This EEPROM cannot be written to when the memory module is installed in a PC. Third party tools do exist that can write to the EEPROM when the memory module is not installed in a PC. There are various third party tools available to read SPD memory.

3. **Does the “Firmware Hub for System BIOS” contain the BIOS program? Is this chip writable, and if so how?**

   The Firmware Hub does contain the BIOS program and is writable. A utility is required to perform the write function.

4. **In some PC systems, the Firmware Hub for System BIOS is a flash memory chip so that updates can be written by the customer. Is this true for these BIOS chips?**

   Yes, they are flash memory chips.

5. **What is meant by “Restore the nonvolatile memory found in Intel-based system boards”?**

   This relates to clearing the Real Time Clock (RTC) CMOS memory that contains PC configuration data.

6. **Does resetting the CMOS configuration memory return the PC back to factory defaults?**

   The process of resetting the CMOS will return certain system settings to factory default but will not reset many of the system data and configuration defaults to their factory settings. To return these system data and configuration defaults to factory settings, refer to question and answer 1 and follow the instructions for returning the BIOS settings to factory defaults.
The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts ac, or from 220 to 240 volts ac.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where the computer is used.

Requirements for all countries and regions

The following requirements are applicable to all countries and regions:

- The length of the power cord set must be at least **1.5 m** (5.0 ft) and no more than **2.0 m** (6.5 ft).
- All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the country or region where the power cord set will be used.
- The power cord sets must have a minimum current capacity of 10 A and a nominal voltage rating of 125 or 250 V ac, as required by the power system of each country or region.
- The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for specific countries and regions

<table>
<thead>
<tr>
<th>Country/region</th>
<th>Accredited agency</th>
<th>Applicable note number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>IRAM</td>
<td>1</td>
</tr>
<tr>
<td>Australia</td>
<td>SAA</td>
<td>1</td>
</tr>
<tr>
<td>Austria</td>
<td>OVE</td>
<td>1</td>
</tr>
<tr>
<td>Belgium</td>
<td>CEBEC</td>
<td>1</td>
</tr>
<tr>
<td>Brazil</td>
<td>ABNT</td>
<td>1</td>
</tr>
<tr>
<td>Canada</td>
<td>CSA</td>
<td>2</td>
</tr>
<tr>
<td>Chile</td>
<td>IMQ</td>
<td>1</td>
</tr>
<tr>
<td>Denmark</td>
<td>DEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Finland</td>
<td>FIMKO</td>
<td>1</td>
</tr>
<tr>
<td>France</td>
<td>UTE</td>
<td>1</td>
</tr>
<tr>
<td>Germany</td>
<td>VDE</td>
<td>1</td>
</tr>
<tr>
<td>India</td>
<td>ISI</td>
<td>1</td>
</tr>
<tr>
<td>Israel</td>
<td>SII</td>
<td>1</td>
</tr>
<tr>
<td>Italy</td>
<td>IMQ</td>
<td>1</td>
</tr>
<tr>
<td>Country/region</td>
<td>Accredited agency</td>
<td>Applicable note number</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Japan</td>
<td>JIS</td>
<td>3</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>KEMA</td>
<td>1</td>
</tr>
<tr>
<td>New Zealand</td>
<td>SANZ</td>
<td>1</td>
</tr>
<tr>
<td>Norway</td>
<td>NEMKO</td>
<td>1</td>
</tr>
<tr>
<td>The People’s Republic of China</td>
<td>CCC</td>
<td>4</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>SASO</td>
<td>7</td>
</tr>
<tr>
<td>Singapore</td>
<td>PSB</td>
<td>1</td>
</tr>
<tr>
<td>South Africa</td>
<td>SABS</td>
<td>1</td>
</tr>
<tr>
<td>South Korea</td>
<td>KTL</td>
<td>5</td>
</tr>
<tr>
<td>Sweden</td>
<td>SEMKO</td>
<td>1</td>
</tr>
<tr>
<td>Switzerland</td>
<td>SEV</td>
<td>1</td>
</tr>
<tr>
<td>Taiwan</td>
<td>BSMI</td>
<td>6</td>
</tr>
<tr>
<td>Thailand</td>
<td>TISI</td>
<td>1</td>
</tr>
<tr>
<td>The United Kingdom</td>
<td>ASTA</td>
<td>1</td>
</tr>
<tr>
<td>The United States</td>
<td>UL</td>
<td>2</td>
</tr>
</tbody>
</table>

1. The flexible cord must be Type H05VV-F, 3-conductor, 0.75mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SVT/SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type with a NEMA 5-15P (15 A, 125 V ac) or NEMA 6-15P (15 A, 250 V ac) configuration. CSA or C-UL mark. UL file number must be on each element.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese Deniori Law. The flexible cord must be Type VCTF, 3-conductor, 0.75mm² or 1.25mm² conductor size. The wall plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V ac) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75mm² conductor size. Power cord set fittings (appliance coupler and wall plug) must bear the CCC certification mark.

5. The flexible cord must be Type H05VV-F 3X0.75mm² conductor size. KTL logo and individual approval number must be on each element. Corset approval number and logo must be printed on a flag label.

6. The flexible cord must be Type HVCTF 3X1.25mm² conductor size. Power cord set fittings (appliance coupler, cable, and wall plug) must bear the BSMI certification mark.

7. For 127 V ac, the flexible cord must be Type SVT or SJT 3 x 18 AWG, with plug NEMA S-15P (15 A, 125 V ac), with UL and CSA or C-UL marks. For 240 V ac, the flexible cord must be Type H05VV-F 3X0.75/1.00mm² conductor size, with plug BS 1363/A with BSI or ASTA marks.

140 Chapter 18  Power cord set requirements
Recycling

Battery

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose of the battery in general household waste. Follow the local laws and regulations in your area for battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable batteries. For more information about recycling programs, see the HP Web site at http://www.hp.com/recycle.

Display

⚠️ **WARNING!** The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging this component and causing exposure to the mercury.

⚠️ **CAUTION:** The procedures in this chapter can result in damage to display components. The only components intended for recycling purposes are the LCD panel and the backlight. When you remove these components, handle them carefully.

**NOTE:** **Materials Disposal.** This HP product contains mercury in the backlight in the display assembly that might require special handling at end-of-life. Disposal of mercury may be regulated because of environmental considerations. For disposal or recycling information, contact your local authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

**NOTE:** The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.
2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).

4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.
6. Remove the display panel assembly (2) from the display enclosure.

7. Position the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Position the display panel right-side up.

15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Position the display panel upside-down.

⚠️ **WARNING!** The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging this component and causing exposure to the mercury.
17. Remove the backlight frame from the display panel.

18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.
23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
AC adapter, spare part numbers 28
AC adapter/battery light 16
antennas
disconnecting 45, 47
audio, product description 4
audio-in (microphone) jack, identifying 18
audio-out (headphone) jack, identifying 18

backup 123
Backup and Restore 111
backup tools 109
backups 117
creating 110
recovering 111
base enclosure, spare part number 24
battery
spare part number 24, 36
battery bay, identifying 15
battery connector cable
removal 71
spare part number 71
battery connector cable, illustrated 27
battery lock latch 15
battery release latch 15
BIOS
determining version 90, 95, 101, 105
downloading an update 91, 96, 101, 106
updating 90, 95, 101, 105
Blu-ray ROM DVD±RW SuperMulti specifications 132
Blu-ray ROM DVD±RW SuperMulti DL Drive, spare part number 25, 28, 43
Bluetooth card
spare part number 45
Bluetooth label 19
boot order
changing 121
bottom 19
buttons
left TouchPad 10
optical drive eject 18
power 12
right TouchPad 10
Cable Kit
contents 27
spare part number 27
cables, service considerations 31
caps lock light, identifying 11
card reader board
removal 63
spare part number 22, 63
chipset, product description 2
components
bottom 14
display 9
front 16
left side 16
right side 18
top 10
computer reset 125
Computer Setup
navigating and selecting 89, 94, 99, 104
restoring factory settings 90, 95, 100, 105
computer setup
navigating and selecting 104
restoring factory settings 105
computer specifications 127
connector, power 16
connectors, service considerations 31
diskette drive
precautions 31
display assembly
removal 82
spare part numbers 82
display bezel
removal 84
spare part numbers 26
display component recycling 141
display components, spare part numbers 26
display hinge
removal 86
Display Hinge Kit
spare part numbers 27
display panel
product description 2
display rear cover
spare part number 27
display specifications 128
Driver Recovery DVD,
creating 109
using for restore 112
Drives
preventing damage 31
DVD-ROM drive, spare part number 25, 28, 43
DVD-ROM drive, specifications 132
DVD±RW SuperMulti DL Drive specifications 131
DVD±RW SuperMulti DL Drive, spare part number 25, 28, 43
E
electrostatic discharge 32
embedded numeric keypad,
identifying 14
esc key, identifying 13
Ethernet, product description 4
external media cards, product description 5
external monitor port 17
F
f11 recovery 112, 115
fan removing 69
spare part number 24
fingerprint reader identifying 13
fingerprint reader assembly removal 59
spare part number 22, 59
fn key, identifying 13
function board removal 62
spare part number 22, 62
function keys, identifying 14

G
graphics, product description 2
grounding equipment and methods 34

H
hard drive
precautions 31
product description 3
removal 39
spare part numbers 24, 28, 39
Hard Drive Hardware Kit, spare part number 28
hard drive light 16
hard drive recovery 112, 115
hard drive, identifying 15
HDMI port
identifying 17
headphone (audio-out) jack 18
heat sink
removal 79
spare part number 24, 79
heat sink assembly
spare part number 24, 79
hinge
removal 86
HP PC Hardware Diagnostics (UEFI)
using 107
HP Recovery Disc Creator, using 109
HP Recovery Manager
correcting boot problems 121
starting 120
HP Recovery media
creating 117
recovery 120
HP Recovery partition
checking for presence 112
recovery 120
removing 122
using for recovery 112

I
integrated webcam light, identifying 9
internal display switch 9
internal microphones, identifying 9

J
jacks
audio-in (microphone) 18
audio-out (headphone) 18
network 17
RJ-45 (network) 17

K
keyboard
product description 5
removal 49
spare part numbers 22, 49
keypad
embedded numeric 14
keys
esc 13
fn 13
function 14
Windows applications 14
Windows key 13

L
labels
Bluetooth 19
regulatory 19
serial number 19
service 19
wireless certification 19
WLAN 19
latch, battery lock 15
latch, battery release 15
legacy support, USB 89, 94, 99, 104
lights
AC adapter/battery 16
caps lock 11
hard drive 16
microphone mute 11
num lock 11
power 11
RJ-45 (network) 17
TouchPad 11
webcam 9
wireless 11

M
mass storage devices, spare part numbers 28
memory card reader, identifying 16
memory module
identifying 15
product description 3
removal 41
spare part numbers 23, 41
microphone (audio-in) jack
product description 4
microphone (audio-in) jack,
identifying 18
microphone module
spare part number 26
microphone mute light, identifying 11
minimized image recovery 120
minimized image, creating 119
model name 1

N
network jack, identifying 17
num lock light 11

O
operating system, product description 6
optical drive
precautions 31
product description 4
removal 43
spare part numbers 25, 28, 43
specifications 131, 132
optical drive eject button,
identifying 18
optical drive extension board
removal 76
spare part number 24, 76
optical drive, identifying 18
original system recovery 119

P
packing guidelines 33
plastic parts 30
pointing device, product description 5
ports 17
e external monitor HDMI 17
product description 5
USB 18
power button 12
identifying 12
power button board assembly removal 60
spare part number 22, 60
power cable removal 88
spare part number 24, 88
power connector, identifying 16
power cord set requirements 139
spare part numbers 28, 29
power lights 11
power requirements, product description 6
processor product description 1
product description audio 4
chipset 2
display panel 2
Ethernet 4
external media cards 5
graphics 2
hard drives 3
keyboard 5
memory module 3
microphone 4
operating system 6
optical drives 4
pointing devices 5
ports 5
power requirements 6
processors 1
product name 1
security 6
serviceability 8
webcam 4
wireless 4
product name 1
product name and number, computer 19

R
recover options 119
recovery 116, 123
discs 118, 120
HP Recovery Manager 119
media 120
starting 120
supported discs 118
system 119
USB flash drive 120
using HP Recovery media 118
recovery media creating 109, 117
creating using HP Recovery Manager 118
using for restore 112
recovery partition 112, 115
removing 122
recovery tools 109
recovery tools, Windows 111
recovery, system 111
refresh 116
regulatory information regulatory label 19
wireless certification labels 19
removal/replacement preliminaries 30
procedures, Authorized Service Provider 53
procedures, Customer Self-Repair 35
reset 116
computer 125
steps 125
restoring the hard drive 112, 115
RJ-45 (network) jack, identifying 17
RJ-45 (network) lights, identifying 17
RTC battery spare part number 24
RTC battery, HP 440 models removal 77
spare part number 77
RTC battery, HP 445 models removal 56
spare part number 56
security cable slot, identifying 16
security, product description 6
serial number 19
serial number, computer 19
service considerations 30
service door spare part number 24, 37
service labels, locating 19
serviceability, product description 8
setup utility navigating and selecting 89, 94, 99
restoring factory settings 90, 95, 100
SIM slot, identifying 15
slots security cable 16
SIM 15
solid-state drive spare part numbers 25, 28, 39
specifications 130
speaker assembly removal 57
spare part number 24, 57
speakers, identifying 13
specifications Blu-ray ROM DVD±RW SuperMulti 132
computer 127
display 128
DVD-ROM drive 132
DVD±RW SuperMulti DL Drive 131
hard drive 129
optical drive 131, 132
solid-state drive 130
Startup Repair, using 111
static-shielding materials 34
supported discs, recovery 118
Sure Start using 103
system board removal 72
spare part numbers 22, 72
system recovery 119
system restore point creating 118
system restore point, creating 117

S
Screw Kit, spare part number 29
serial number, computer 19
thermal material, replacement 80, 81
tools required 30
top cover
- removal 53
- spare part number 22, 53
TouchPad
- buttons 10
touchpad button board
- removal 67
- spare part number 22, 67
TouchPad light, identifying 11
TouchPad zone
- identifying 10
TPM settings 102
transporting guidelines 33
traveling with the computer 19

Ubuntu
- remove everything and reinstall option 125
USB 3.0 port 17
USB legacy support 89, 94, 99, 104
USB ports, identifying 17, 18
USB/audio board
- removal 65
- spare part number 23, 65

vents, identifying 14, 16

windows applications key,
- identifying 14
Windows key, identifying 13
Windows operating system DVD 116
Windows Startup Repair, using 111
Windows tools
- using 118
wireless antennas
- disconnecting 45, 47
wireless antennas, identifying 9
wireless certification label 19
wireless light 11
wireless, product description 4
WLAN antennas
- spare part number 27
WLAN antennas, identifying 9
WLAN device 19
WLAN label 19
WLAN, identifying 15
WLAN/Bluetooth combo card
- removal 45
- spare part number 24, 45
workstation guidelines 33
WWAN
- identifying 15
WWAN antennas
- spare part number 27
WWAN antennas, identifying 9
WWAN module
- removal 47
- spare part number 24, 47
webcam
- identifying 9
- product description 4
webcam light, identifying 9
webcam module
- removal 85
- spare part number 26
Windows
- Refresh 116
- Reset 116
- system restore point 117, 118
Windows 7 operating system DVD
- creating 109
- using for restore 112
Windows 7 operating system media
- creating 109
- using for restore 112